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PART I. CPU/BACKPLANE
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1. INTRODUCTION

Chapter 1 introduces the Smart Star embedded control system
and describes the features associated with the backplane chassis
and the CPU Card. The Tool Kit containing the hardware essen-
tials to begin using the Smart Star is described, and the software
highlights are presented.

The Smart Star is a modular and expandable embedded control system whose configuration
of Digital 1/0, A/D Converter, D/A Converter, and Relay Cards can be tailored to a large
variety of demanding real-time control and data acquisition applications.

The typical Smart Star system consists of a rugged backplane with a built-in voltage regulator,
a CPU Card, and one or more 1/0O cards. The CPU Card plugs into a designated slot on the
backplane chassis, which has additional slots available for any combination of 1/0 cards.

A high-performance Rabbit 2000 microprocessor on the CPU Card operates at 22.1 MHz
to provide fast data processing.

1.1 Features

e C-programmable to create a custom user interface

o Flexible functionality—modular configuration allows interchanging or replacing indi-
vidual 1/0 cards

e Expandable—up to 168 1/O ports
e Choice of two backplanes—with either 3 or 7 slots for 1/O cards

e Choice of CPU cards—with or without one RJ-45 10/100-compatible Ethernet port
with 10Base-T Ethernet interface

e RS-232 and RS-485 serial ports allow networking to other Smart Star units, single-
board computers, or enterprise computing centers

e 128K SRAM and 512K flash memory, optional 512K SRAM
e Real-time clock

e Watchdog supervisor

e Backup battery

e Optional backlit 122 x 32 graphic display/keypad module

¢ RabbitLink Ethernet gateway available for remote download/debug, Web serving, and
e-mail
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Table 1 lists the backplanes, CPU cards, and the 1/O cards that are available for the Smart
Star control system. Appendix A provides detailed specifications for the Smart Star back-
planes and the CPU cards.

Table 1. Smart Star Backplanes and Cards

Card Model Features

7 1/0 card slots, 1 CPU card slot, header connections

SR9010 for optional LCD/keypad module
Backplane
SR9050 31/0O card slots, 1 CPU card slot, header connections
for optional LCD/keypad module
SR9150 Full-featured CPU card with RJ-45 Ethernet port
CPU
SR9160 Full-featured CPU card without RJ-45 Ethernet port
SR9200 16 digital inputs, 8 digital sinking outputs
SR9210 8 digital inputs, 16 digital sinking outputs
SR9220 8 digital inputs, 8 digital sinking outputs
Digital I/0

SR9205 16 digital inputs, 8 digital sourcing outputs

SR9215 8 digital inputs, 16 digital sourcing outputs

SR9225 8 digital inputs, 8 digital sourcing outputs

SR9300 12-bit A/D converter, 11 channels, 0 V — 10 V

A/D Converter SR9310 12-bit A/D converter, 11 channels, -10 V —+10 V

1/0 Cards

SR9320 12-bit A/D converter, 11 channels, 4 mA — 20 mA

SR9400 12-bit D/A converter, 8 channels, 0 V - 10 V

D/A Converter SR9410 12-bit D/A converter, 8 channels, -10 V —+10 V

SR9420 12-bit D/A converter, 8 channels, 4 mA — 20 mA

5 SPST relays and 1 SPDT relay, each protected

SR9500 with onboard snubbers

Relay

SR9510 8 SPDT relays (no snubbers)
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1.2 User Connections

Connections to the 1/O cards are made via a ribbon cable connector or optional field wir-
ing terminals that are either pluggable or have screw terminals. Three different Field Wir-
ing Terminals (FWTSs) are available. Table 2 lists the 1/O cards and the Rabbit part
numbers for the corresponding FWTs.

Table 2. Guide to FWT Selection

Rabbit Part Number
Pluggable Terminals Screw Terminals

FWT Description I/O Cards
Digital I/0

FWT27 Relay (SR9510) 101-0420 101-0514

A/D Converter
FWT18 DIA Converter 101-0421 101-0515
FWT18R Relay (SR9500) 101-0422 101-0516

NOTE: Appendix A, “Field Wiring Terminals,” provides further information on FWTs,
including their dimensions.

1.3 Optional Add-Ons
The LCD/keypad module is the only available optional add-on. Further details on the
LCD/keypad module are provided in Appendix B.

Visit our \Web site for up-to-date information about additional add-ons and features as
they become available. The Web site also has the latest revision of this user’s manual.
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1.4 Development and Evaluation Tools
1.4.1 Tool Kit

The Tool Kit has the hardware essentials that you need to create and use your own Smart
Star control system.

The items in the Tool Kit and their use are as follows:

e Smart Star (SR9000) Getting Started instructions.
e Dynamic C CD-ROM, with complete product documentation on disk.

e Programming cable, used to connect your PC serial port to the Smart Star CPU Card to
write and debug C programs that run on the Smart Star control system.

e FWT27 pluggable field wiring terminal.
e Screwdriver.

e DC power supply, used to power the backplane, which in turn supplies power to the
CPU card and the 1/O cards. The DC power supply accepts an AC input of 100 V to
240V atupto 0.6 A, and delivers a DC output up to 1.1 A at 24 V.

e Rabbit 2000 Processor Easy Reference poster.
e Registration card.

1.4.2 Software

The Smart Star control system is programmed using Rabbit’s Dynamic C. A compatible
version is included on the Tool Kit CD-ROM.

Rabbit also offers add-on Dynamic C modules containing the popular uC/OS-11 real-time
operating system, as well as PPP, Advanced Encryption Standard (AES), and other select
libraries. In addition to the Web-based technical support included at no extra charge, a
one-year telephone-based technical support module is also available for purchase. Visit
our Web site at www.rabbit.com or contact your Rabbit sales representative or authorized
distributor for further information.
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1.5 CE Compliance

Equipment is generally divided into two classes.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:
less than 40 dB pV/mat 10 m
(40 dB relative to 1 uV/m) or 300 uV/m

More restrictive emissions requirement:
30 dB uV/mat 10 m or 100 uV/m

These limits apply over the range of 30-230 MHz. The limits are 7 dB higher for frequencies
above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-based
systems at frequencies above 300 MHz are generally well below background noise levels.

The CPU card, 1/0 cards, and backplane in the Smart Star embedded control system have
been tested and were found to be in conformity with the following applicable immunity
and emission standards as described in Table 3.

Table 3. CE Compliance of Smart Star Backplanes and Cards

Used for CE
Card Model Description Compliance
Testing
7 1/O card slots, 1 CPU card slot,
SR9010 header connections for optional Full-featured X
LCD/keypad module*
Backplane
3 1/0 card slots, 1 CPU card slot,
SR9050 header connections for optional Sub-version
LCD/keypad module*
cpU SR9150 |22.1 MHz CPU card with Ethernet Full-featured X
SR9160 |22.1 MHz CPU card without Ethernet | Sub-version
SR9200 |16 inputs, 8 sinking outputs Full-featured X
. SR9205 |16 inputs, 8 sourcing outputs Full-featured X
Digital 1/0
SR9210 |8 inputs, 16 sinking outputs Sub-version
SR9220 |8 inputs, 8 sinking outputs Sub-version
(%)
E SR9300 | Eleven 12-bit analog inputs (0-10 V) | Sub-version
g A/D Converter | SR9310 |Eleven 12-bit analog inputs (£10 V) Full-featured X
SR9320 | Eleven 12-bit analog inputs (4-20 mA) | Sub-version
SR9500 5 SPST relays_ and 1 SPDT relay, each Full-featured »
protected with onboard snubbers
Relay
SR9510 |8 SPDT relays (no snubbers) Full-featured X

* No CE compliance testing was done with the LCD/keypad module connected to a Smart Star
embedded control system. A system consisting of Smart Star boards and an LCD/keypad mod-
ule therefore cannot be considered to be CE-compliant.
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The sub-versions of the boards are also CE-compliant. All boards that
are CE-compliant have the CE mark.

Several Smart Star boards are not yet CE-compliant. These boards are
listed in Table 4.

Table 4. Smart Star Backplanes and Cards Not CE-Compliant

Card Model Description Comments
Backplane SR9000 7 1/0 card slots, 1 CPU card slot | Legacy product
CPU SR9100 25.8 MHz CPU card Legacy product

SR9400 Eight analog outputs (0-10 V)

Passed emissions tests,

D/A Converter SR9410 Eight analog outputs (10 V) immunity tests pending

SR9420 Eight analog outputs (4-20 mA)

Immunity
The CE-compliant Smart Star boards meet the following EN55024/1998 immunity standards.
e EN61000-4-3 (Radiated Immunity)

e EN61000-4-4 (EFT)
e EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.
Emissions

The CE-compliant Smart Star boards meet the following emission standards when used
with a Smart Star embedded control system that contains a Rev. C or higher version of the
Rabbit 2000 microprocessor with its spectrum spreader turned on and set to the normal
mode. This microprocessor is used in all Smart Star CPU boards that carry the CE mark.

e EN55022:1998 Class A
e FCC Part 15 Class A
NOTE: The Smart Star embedded control system satisfied the Class A limits but not the

Class B limits. Such equipment need not be restricted in its sale, but the following
warning must be included in the instructions for its use.

Warning
This is a class A product. In a domestic environment this product may cause radio inter-
ference, in which case the user may be required to take adequate measures.

Additional shielding or filtering may be needed to meet Class B emissions standards.
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1.5.1 Design Guidelines

Note the following requirements for incorporating a Smart Star embedded control system
into your application to comply with CE requirements.

General

e The power supply provided with the Tool Kit is for development purposes only. It is the
customer’s responsibility to provide a CE-compliant power supply for the end-product
application.

e When connecting the Smart Star embedded control system to outdoor cables, the cus-
tomer is responsible for providing CE-approved surge/lighting protection.

¢ Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a
metal conduit to assist in maintaining CE compliance and to conform to good cable
design practices.

e When installing or servicing the Smart Star embedded control system, it is the responsi-
bility of the end-user to use proper ESD precautions to prevent ESD damage to the
Smart Star.

Safety

e All inputs and outputs to and from the Smart Star embedded control system must not be
connected to voltages exceeding SELV levels (42.4 VV AC peak, or 60 VV DC).

e The lithium backup battery circuit on the CPU card in the Smart Star embedded control
system has been designed to protect the battery from hazardous conditions such as
reverse charging and excessive current flows. Do not disable the safety features of the
design.

1.5.2 Interfacing the Smart Star to Other Devices

Since Smart Star embedded control systems are designed to be connected to other devices,
good EMC practices should be followed to ensure compliance. CE compliance is ulti-
mately the responsibility of the integrator. Additional information, tips, and technical
assistance are available from your authorized Rabbit distributor, and are also available on
our Web site at www.rabbit.com.
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2. GETTING STARTED

Chapter 2 explains how to connect the power supply to the
Smart Star backplane, how to install the CPU Card on the back-
plane, and how to connect the programming cable to the CPU
Card. Once you run a sample program to demonstrate that you
have connected everything correctly, you will be ready to go on
to install 1/0 cards and finish developing your system.
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2.1 Attach the CPU Card to the Backplane

1. Orient the backplane with the PROCESSOR SLOT facing away from you as shown in
Figure 1.

Align facing edge of
CPU card with back
edge of alignment hole

Align facing edge of
CPU card with back
edge of alignment hole

Figure 1. Attach the CPU Card to the Backplane

2. Position the CPU Card above the backplane as shown in Figure 1.

3. Carefully insert the CPU Card header into the PROCESSOR SLOT on the backplane
and line up the facing edge of the CPU Card with the back edge of the alignment holes
on the backplane as shown in Figure 1.

NOTE: Be careful to line up the pins on the CPU Card with the socket on the backplane when
installing the CPU Card. The CPU Card can be damaged once power is applied if the CPU Card
is not installed correctly.

4. Use the two 4-40 screws supplied with the CPU Card to anchor the plastic brackets so
that they hold the CPU Card firmly in place on the backplane.
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2.2 Connect the Power Supply

Connect the power supply to the POWER IN
connector on the backplane—the red (posi-
tive) wire to +RAW and the black (negative)
wire to GND, as shown in Figure 2.
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Figure 2. Power Supply Connections

(North America)

A USER connection is supplied on the
backplane to allow an independent power
supply to be used for future development.
For now, use a wire jumper to connect
USER to +RAW so that they share the same
power supply.

NOTE: Be careful to hook up
the positive and negative leads
exactly as described. Only the
+5 V circuitry is protected
against reverse polarity.

Notice to Customers
Outside North America

The power supply included with the Smart Star
Tool Kit may be used worldwide. Customers
outside North America simply need to
exchange the line cord and plug from the
power supply to their wall outlet with one
available locally.

1. To exchange the line cord and plug, first
remove the existing line cord. To access the
screws, use a screwdriver to gently lift up
and remove the plastic insulating cover.

To
Smart Star To ?I/at”
POWER IN outie

=
(1.8 OO bdhdbd]

Plastic
Insulating j )
Cover

Figure 3. Power Supply Connections
(overseas)

2.Unscrew the wires at the ground, L, and N
terminals.

3.Attach the line cord that you obtained locally
to the power supply. Be sure to follow any
color-coding conventions, for example,
green/yellow to ground, brown to L, and
blue to N terminals.

4.Ensure that the wires are attached securely
and are not touching each other. Snap on
the plastic insulating cover.

NOTE: The power supply included
with the Smart Star Tool Kit is
intended for development purposes
only.
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2.3 Programming Cable Connections

1. Connect the programming cable to the CPU Card.

Connect the 10-pin PROG connector of the programming cable to header J2 on the CPU
Card as shown in Figure 4. Connect the other end of the programming cable to a COM
port on your PC. Note that COM1 on the PC is the default COM port in the Dynamic C
installation.

NOTE: Be sure to use the programming cable (Part No. 101-0513) supplied with the
Smart Star Tool Kit—the programming cable has red shrink wrap around the RS-232
converter section located in the middle of the cable. Programming cables from other
Rabbit kits are not designed to work with the Smart Star.

piAG[]| Diagnostic

connector

Red /
shrink wrap TO

PC COM port

Colored side
towards pin 1

rRod || Programming
connector

Figure 4. Programming Cable Connections

NOTE: Never disconnect the programming cable by pulling on the ribbon cable.
Carefully pull on the connector to remove it from the header.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use
an RS-232/USB converter (Part No. 20-151-0178) with the programming cable sup-
plied with the Tool Kit. Note that not all RS-232/USB converters work with Dynamic C.
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2. Apply power.
Plug the power supply in to a nearby outlet. The CPU Card is now ready to be used.

NOTE: A hardware RESET is accomplished by unplugging the power supply, then plug-
ging it back in.

To power down the SmartStar, unplug the power supply. You should disconnect power
before making any circuit adjustments or changing any connections to the SmartStar.
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2.4 Installing Dynamic C

If you have not yet installed Dynamic C version 7.06P3 (or a later version), do so now by
inserting the Dynamic C CD from the Smart Star Tool Kit in your PC’s CD-ROM drive.
The CD will auto-install unless you have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and
browse for the setup . exe file on your CD drive. Click OK to begin the installation once
you have selected the setup . exe file.

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, create a new desktop icon that points to default.htm in the
docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.

The Dynamic C User’s Manual provides detailed instructions for the installation of
Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default instal-
lation of the later version will be in a different folder, and a separate icon will appear on
your desktop.
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2.5 Starting Dynamic C

Once the CPU Card is installed and connected as described above, start Dynamic C by
double-clicking on the Dynamic C icon or by double-clicking on decrab XXXX.exe in the
Dynamic C root directory, where XXXX are version-specific characters.

Dynamic C defaults to using the serial port on your PC that you specified during installa-
tion. If the port setting is correct, Dynamic C should detect the CPU Card and go through
a sequence of steps to cold-boot the CPU Card and to compile the BIOS. (Some versions
of Dynamic C will not do the initial BIOS compile and load until the first time you com-
pile a program.)

If you receive the message No Rabbit Processor Detected, the programming
cable may be connected to the wrong COM port, a connection may be faulty, or the target
system may not be powered up. First, check both ends of the programming cable to ensure
that it is firmly plugged into the PC and the programming port.

If there are no faults with the hardware, select a different COM port within Dynamic C.
From the Options menu, select Communications. Select another COM port from the list,
then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C
still reports it is unable to locate the target system, repeat the above steps until you locate the
active COM port. You should receive a Bios compiled successfully message
once this step is completed successfully.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load a sample program, it is possible that your
PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Communications
menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Communications
menu. Choose a lower debug baud rate.
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2.6 PONG.C
You are now ready to test your set-up by running a sample program.

Find the file PONG. ¢, which is in the Dynamic C saMPLES folder. To run the program,
open it with the File menu (if it is not still open), compile it using the Compile menu, and
then run it by selecting Run in the Run menu. The STDIO window will open and will dis-
play a small square bouncing around in a box.

This program does not test the serial ports on the CPU Card, but does ensure that the CPU
is basically functional.
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2.7 Installing I/O Cards

1. Orient the backplane with the CPU Card already installed and facing towards you as
shown in Figure 5.

plastic brackets when you
install I/O cards starting
from the slot furthest away
from the CPU card. You
may have to remove the
CPU card to install the
brackets on the 1/O card

in SLOT 0.

J
Tip: It's easier to install the é

|

|

000000000000
00000000000(

Place tabs on

card into
alignment slot i
=

EOO EOOOO
000 00000

0000000000000 0000000000000
00000000000 0000O000OO000oN

Note: The plastic brackets
on the CPU card are
attached on the opposite

[ side of the board relative
to the I/O cards.
4 power supply

Figure 5. Installing I/O Cards on the Backplane

2. Position the new 1/0O card above the backplane over any unused slot position (SLOT 0 to
SLOT 6) as shown in Figure 5. Note the slot number and the type of 1/0O card since
Dynamic C addresses the 1/0O cards by slot number.

3. Carefully insert the 1/O card header into the slot on the backplane and line up the tabs
on the 1/0O cards with the slots on the backplane as shown in Figure 5.

4. Use the two 4-40 screws supplied with the 1/0 card to anchor the plastic brackets on the CPU
Card or the 1/0 card firmly on the backplane. Tighten the screws as needed using a Phillips
screwdriver whose shaft is at least 3" (7 cm) long, but is no thicker than 0.16" (4 mm).
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2.8 Where Do | Go From Here?

NOTE: If you purchased your Smart Star through a distributor or Rabbit partner, contact
the distributor or partner first for technical support.

If there are any problems at this point:

e Use the Dynamic C Help menu to get further assistance with Dynamic C.
e Check the Rabbit Technical Bulletin Board at www.rabbit.com/support/bb/.
e Use the Technical Support e-mail form at www.rabbit.com/support/.

If the sample program ran fine, you are now ready to go on to install 1/O cards, explore
other Smart Star features, and develop your own applications.

Chapter 3, “Hardware Features,” provides detailed information about the CPU Card, and
how to install the 1/O cards. Be sure to take the total current consumption of the individual
cards into account when selecting a power supply. Appendix C.1, “Current Require-
ments,” provides more detailed information. Chapter 4, “Software,” describes the
Dynamic C software libraries and introduces some sample programs for use with the CPU
Card. Chapter 6, “Smart Star Specifications,” provides specifications for the backplanes
and the CPU cards, including mounting and clearance recommendations.

Separate sections in this manual have been prepared for the various 1/0O cards, and include
complete information about their pinouts and Dynamic C software libraries, including
sample programs.

Once you have developed your application and bench-tested the finished system, you may
install the finished system.
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3. HARDWARE FEATURES

Chapter 3 describes the principal features for the Smart Star
backplanes and CPU cards.

» Power Distribution
- Power Distribution
- 1/O Card Slots

» Smart Star CPU Card Features
- Serial Communication
- Memory
- Other Connectors
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3.1 Backplane Features
3.1.1 Power Distribution

Power is supplied to the Smart Star control system from an external source through header
J1 on the backplane. The +5 V circuitry on the Smart Star control system is protected
against reverse polarity by a Schottky diode as shown in Figure 6.

+V_USER

" +RAW SWITCHING VOLTAGE +5V
— I REGULATOR I
L
=0 .
o

I *

Figure 6. Smart Star Control System Power Supply Schematic

A capacitor provides surge current protection for the voltage regulator, and allows the
external power supply to be located some distance away from the Smart Star control sys-
tem. A switching power regulator is used. The +RAW input voltage may range from 9 V to
30V (15 V to 30 V you plan to use a D/A Converter Card).

The backplane has inputs for two separate power supplies on header J1, +RAW and
V_USER. The +RAW power supply goes to the switching power regulator, which outputs
the +5 V DC used by the CPU Card and by the 1/O cards plugged into the backplane. The

V_USER connection allows a different voltage to be available on the 1/O cards for future
development.

NOTE: Always connect V_USER to +RAW with a jumper wire between terminals 1 and 2
on header J1 for the development activities described in the Smart Star manuals.
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Figure 7 shows how the power supplies are distributed on the backplane and on the CPU Card.

(b) CPU Card

Power In SLOTO0...6
24V DC power +RAW +*RAW | +5 V switching | +5V 20 ]
supply included 9-30 VDC regulator

in Tool Kit . —
= Jumper
, +V_USER
poney supply | VUSER oo -
(for future use) 9-30VDC — -lfl_
i (a) Backplane i
PROCESSOR
SLOT
[ 1. +5V Backup Battery
|J_:|M le/s 3V DC
CPU logic, ’/RAM
2 +V_USER memory SRAM. CPU,
RTC
51 +RAW
1,26, 52

Figure 7. Smart Star Power Supplies—Backplane and CPU Card
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Figure 8 shows how the power supplies are distributed on the 1/0 cards.

+5V
+RAW
+V_USER )
K
Multiplexer/Latch = — Relay Coils
High-Voltage Outputs = = Multiplexer/Latch
(user-selectable)
Digital I/0 Relay
Multiplexer/Latch = = Multiplexer/Latch
Voltage Regulators/ = = \/oltage Regulators:
A/D Reference Voltage 12V
A/D Converter D/A Converter

Figure 8. Smart Star Power Distribution on I/O Cards

NOTE: Note that Rabbit recommends tying +RAW to +V_USER as explained in
Section 2.2, “Connect the Power Supply.”

The user has the option of using a separate power supply to K when configuring the high-
power outputs for the digital 1/0 cards. The connection to K is through the user interface
on the digital 1/O card. Further details are provided in Chapter 7, “Digital 1/0 Cards.”
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3.1.2 1/O Card Slots

The backplane serves to make the CPU Card accessible to up to seven 1/O cards plugged

in to SLOT 0 through SLOT 6 on the backplane. Figure 9 shows the pinout for SLOT 0

through SLOT 6 (headers J3-J9) on the backplane.

J3-J9
GND [ {m o 1DO
D1 []o o[ D2
D3 []o o[ D4
D5 ]o o[ D6
D7 [|o o[ A0
A1 [o o[ JA2
A3 []o o[J/IORD
NIOWR [| o © [ /SELECT
INHIB_OUT [] o o [J /ATTNA
/RESET (|0 o[ J+5V
NC []° o[ +V_USER
T™X C]o o [JRX
SCLK | © [ GND

Figure 9. Pinout for SLOT 0 Through SLOT 6
(Headers J3-J9) on the Backplane

NOTE: The SR9050 backplane can accommodate up to three I/O cards plugged in to
sLoT o through sLoT 2 (headers J3-J5).
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3.2 Smart Star CPU Card Features
3.2.1 Serial Communication

The CPU Card has one screw terminal header for RS-232/RS-485 serial communication
(J3) and one RJ-45 Ethernet jack (J7, SR9150 only). The RJ-12 jack, J6, is reserved for
future use and therefore has no signals. The pinouts are shown in Figure 10.

Mode 0: Mode 1: Mode 2:
RS-485/3-wire RS-232 two 3-wire RS-232 one 5-wire RS-232

J3 J3 J3
82
RE g8 sER2R gHEZR
SISISNIEINZ SO606800 SO60600
7 6 5 4 3 2 1 7 6 5 4 3 2 1 7 6 5 4 3 21

J3 J6 J7
SISISINEINZ)

Figure 10. Smart Star CPU Card Serial Pinout

The factory default for the CPU Card is one RS-232 (3-wire) and one RS-485 serial chan-
nel, corresponding to Mode 0 in Figure 10. The other modes shown in Figure 10 are set in
software via the Dynamic C serMode function call (see Section 4.5, “Serial Communica-
tion Calls™).

3.2.1.1 RS-232

The CPU Card’s RS-232 serial channel is connected to an RS-232 transceiver. The trans-
ceiver provides the voltage output, slew rate, and input voltage immunity required to meet
the RS-232 serial communication protocol. Basically, the chip translates the Rabbit 2000°s
0 V to +Vcc signals to RS-232 signal levels. Note that the polarity is reversed in an
RS-232 circuit so that +5 V is output as approximately -10 V and 0 V is output as approx-
imately +10 V. The transceiver also provides the proper line loading for reliable communi-
cation.

The maximum baud rate is 115,200 bps. RS-232 can be used effectively at this baud rate
for distances up to 15 m.

The Rabbit 2000 serial port C TXD and RXD signals are presented either as RS-232 TX
and RX or as RTS/CTS handshaking, depending on the mode selected with the Dynamic C
function serMode. The RS-232 signals are available on screw terminal header J3.
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3.2.1.2 RS-485

The CPU Card has one RS-485 serial channel, which is connected to the Rabbit 2000
serial port C through an RS-485 transceiver. The chip’s slew rate limiters provide for a
maximum baud rate of 250,000 bps, and allows networking over a distance of up to 300 m
(or 1000 ft.). The half-duplex communication uses the Rabbit 2000’s PD4 pin to control
the data enable on the communication line.

The RS-485 signals are available on the CPU Card through screw terminal header J3.

The Smart Star control system can be used in an RS-485 multidrop network. Connect the
485+ to 485+ and 485- to 485— using single twisted-pair wires on the CPU Card’s header
J4 as shown in Figure 11. Note that a common ground is recommended.

Ground recommended

Figure 11. Multidrop Smart Star Network
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The CPU Card comes with a 220 Q termination resistor and 681 Q bias resistors already
installed and enabled with jumpers across pins 1-2 and 5-6 on header JP1, as shown in

Figure 12.

Factory
Default

& S
O sl
|I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I
POPPRRRE PR IRrr PR

Figure 12. RS-485 Termination and Bias Resistors

For best performance, the bias and termination resistors in a multidrop network should
only be enabled on both end nodes of the network. Disable the termination and bias resis-
tors on any intervening Smart Star units in the network by removing both jumpers from

header JP1.

TIP: Save the jumpers for possible future use by “parking” them across pins 1-3 and 4-6
of header JP1. Pins 3 and 4 are not otherwise connected to the CPU Card.
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3.2.1.3 Programming Port

The CPU Card has a 10-pin programming header labeled J2. The programming port uses
the Rabbit 2000’s Serial Port A for communication. Dynamic C uses the programming
port to download and debug programs.

The programming port is also used for the following operations.

e Cold-boot the Rabbit 2000 on the RabbitCore module after a reset.

¢ Remotely download and debug a program over an Ethernet connection using the
RabbitLink EG2110.

e Fast copy designated portions of flash memory from one Rabbit-based board (the
master) to another (the slave) using the Rabbit Cloning Board.

Alternate Uses of the Serial Programming Port

All three clocked Serial Port A signals are available as
e asynchronous serial port
e an asynchronous serial port, with the clock line usable as a general CMOS input

The serial programming port may also be used as a serial port via the DIAG connector on
the serial programming cable.

In addition to Serial Port A, the Rabbit 2000 startup-mode (SMODEO, SMODEL), status,
and reset pins are available on the serial programming port.

The two startup mode pins determine what happens after a reset—the Rabbit 2000 is
either cold-booted or the program begins executing at address 0x0000.

The status pin is used by Dynamic C to determine whether a Rabbit microprocessor is
present. The status output has three different programmable functions:

1. It can be driven low on the first op code fetch cycle.
2. It can be driven low during an interrupt acknowledge cycle.
3. It can also serve as a general-purpose CMOS output.

The /RESET _IN pin is an external input that is used to reset the Rabbit 2000 and the
onboard peripheral circuits on the Smart Star. The serial programming port can be used to
force a hard reset on the Smart Star by asserting the /RESET _IN signal.

Refer to the Rabbit 2000 Microprocessor User’s Manual for more information.
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3.2.1.4 Ethernet Port (SR9150 only)

Figure 13 shows the pinout for the Ethernet port (J2 on the CPU Card). Note that there are
two standards for numbering the pins on this connector—the convention used here, and
numbering in reverse to that shown. Regardless of the numbering convention followed,
the pin positions relative to the spring tab position (located at the bottom of the RJ-45 jack
in Figure 13) are always absolute, and the RJ-45 connector will work properly with off-
the-shelf Ethernet cables.

ETHERNET
' | @ |
1. E_Tx+
2. E_Tx—
3. E_Rx+
6. E_Rx—
RJ-45 Plug RJ-45 Jack

Figure 13. RJ-45 Ethernet Port Pinout

RJ-45 pinouts are sometimes numbered opposite to the way shown in Figure 13.

Two LEDs are placed behind the RJ-45 Ethernet jack, one to indicate an Ethernet link
(LNK) and one to indicate Ethernet activity (ACT). Only the CPU LEDs are functional at
this time since the RCM LEDs were added for future enhancements to the CPU Card.

The transformer/connector assembly ground is connected to the CPU Card digital ground
via a 0 Q resistor “jumper,” R43, as shown in Figure 14.

RJ-45 Ethernet Plug

L1

R43
Board Chassis

Ground = = Ground

Figure 14. Isolation Resistor R43

The factory default is for the 0 Q resistor “jumper” at R43 to be installed. In high-noise
environments, remove R43 and ground the transformer/connector assembly directly
through the chassis ground. This will be especially helpful to minimize ESD and/or EMI
problems.
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3.3 Programming Cable

The programming cable is used to connect the programming port of the Smart Star CPU
Card to a PC serial COM port. The programming cable converts the RS-232 voltage levels
used by the PC serial port to the TTL voltage levels used by the Rabbit 2000.

When the PROG connector on the programming cable is connected to the CPU Card’s
programming header, programs can be downloaded and debugged over the serial interface.

The DIAG connector of the programming cable may be used on the CPU Card’s program-
ming header with the Smart Star operating in the Run Mode. This allows the programming
port to be used as a regular serial port.

3.3.1 Changing Between Program Mode and Run Mode

The Smart Star is automatically in Program Mode when the PROG connector on the pro-
gramming cable is attached to the CPU Card, and is automatically in Run Mode when no
programming cable is attached. When the Rabbit 2000 is reset, the operating mode is deter-
mined by the status of the SMODE pins. When the programming cable’s PROG connector
is attached, the SMODE pins are pulled high, placing the Rabbit 2000 in the Program
Mode. When the programming cable’s PROG connector is not attached, the SMODE pins
are pulled low, causing the Rabbit 2000 to operate in the Run Mode.

Program Mode Run Mode

[oRer] Diagnostic

To
PC COM port
Colored side
towards pin 1

[Frod] Programming
connector

RESET Smart Star when changing mode:
Cycle power off/on
after removing or attaching programming cable.

Figure 15. Smart Star Program Mode and Run Mode Set-Up

A program “runs” in either mode, but can only be downloaded and debugged when the
Smart Star is in the Program Mode.

Refer to the Rabbit 2000 Microprocessor User’s Manual for more information on the pro-
gramming port and the programming cable.
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3.3.2 Memory
3.3.2.1 SRAM

The Smart Star CPU Cards are designed to accept 128K or 512K of static RAM packaged
in an SOIC case. Standard CPU Cards come with 128K of SRAM.

3.3.2.2 Flash EPROM

The Smart Star CPU Card are also designed to accept 128K to a total of 512K of flash
memory packaged in a TSOP case. The CPU cards come with two 256K flash memory
chips.

NOTE: Rabbit recommends that any customer applications should not be constrained by
the sector size of the flash memory since it may be necessary to change the sector size
in the future.

A Flash Memory Bank Select jumper configuration option based on 0 € surface-mounted
resistors exists at header JP5 on the CPU Card. This option, used in conjunction with some
configuration macros, allows Dynamic C to compile two different co-resident programs
for the upper and lower halves of the 256K flash in such a way that both programs start at
logical address 0000. This is useful for applications that require a resident download man-
ager and a separate downloaded program. See Technical Note 218, Implementing a Serial
Download Manager for a 256K Flash, for details.
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3.3.3 Other Connectors

The connectors labeled J4 and J5 in Figure 16 are reserved for future use and should not
be used in customer applications at this time.

Figure 16. CPU Card Connectors J4 and J5
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Jumpers across pins 9-10 and 13-14 on header JP1 on the backplane are used to bring out
the ACT and LNK LED signals to header J6, which is used to connect the optional LCD/key-
pad module. Remove these jumpers (you may park them across pins 7-8 and 11-12 on
header JP1) if you do not wish to use the ACT and LNK signals on the LCD/keypad module.
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Figure 17. Header JP1 Configurations for ACT and LNK Signals

NOTE: The RCM positions for pins 1-2 and 5-6 on header JP1 are reserved for future
use and should not be used in customer applications at this time.
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3.4 Other Hardware
3.4.1 Clock Doubler

The Smart Star CPU cards take advantage of the Rabbit 2000 microprocessor’s internal
clock doubler. A built-in clock doubler allows half-frequency crystals to be used to reduce
radiated emissions. The 22.1 MHz frequency is generated using an 11.0592 MHz crystal.
The clock doubler is disabled automatically in the BIOS for crystals with a frequency
above 12.9 MHz.

The clock doubler may be disabled if 22.1 MHz clock speeds are not required. Disabling
the Rabbit 2000 microprocessor’s internal clock doubler will reduce power consumption
and further reduce radiated emissions. The clock doubler is disabled with a simple config-
uration macro as shown below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.
2. Add the line cLock DOUBLED=0 to always disable the clock doubler.

The clock doubler is enabled by default, and usually no entry is needed. If you need to specify
that the clock doubler is always enabled, add the line CLOCK DOUBLED=1 t0 always enable
the clock doubler. The clock speed will be doubled as long as the crystal frequency is
less than or equal to 26.7264 MHz.

3. Click OK to save the macro. The clock doubler will now remain off whenever you are in the
project file where you defined the macro.

3.4.2 Spectrum Spreader

Smart Star CPU cards that carry the CE mark have a Rabbit 2000 microprocessor that fea-
tures a spectrum spreader, which helps to mitigate EMI problems. By default, the spectrum
spreader is on automatically for CPU cards that carry the CE mark when used with Dynamic C
7.32 or later versions, but the spectrum spreader may also be turned off or set to a stronger
setting. The means for doing so is through a simple configuration macro as shown below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.

2. Normal spreading is the default, and usually no entry is needed. If you need to specify normal
spreading, add the line

ENABLE SPREADER=1

For strong spreading, add the line
ENABLE SPREADER=2

To disable the spectrum spreader, add the line
ENABLE SPREADER=0

NOTE: The strong spectrum-spreading setting is unnecessary for the Smart Star.

3. Click OK to save the macro. The spectrum spreader will now remain off whenever you are in
the project file where you defined the macro.

There is no spectrum spreader functionality for Smart Star CPU cards that do not carry the
CE mark or when using any CPU card with a version of Dynamic C prior to 7.30.
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4. SOFTWARE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Rabbit controllers and other controllers
based on the Rabbit microprocessor.

Chapter 4 provides the libraries, function calls, and sample pro-
grams related to the Smart Star backplane and CPU cards.

4.1 Running Dynamic C

You have a choice of doing your software development in the flash memory or in the static
RAM included on the Smart Star CPU cards. The flash memory and SRAM options are
selected with the Options > Program Options > Compiler menu.

The advantage of working in RAM is to save wear on the flash memory, which is limited
to about 100,000 write cycles. The disadvantage is that the code and data might not both
fitin RAM.

NOTE: An application can be developed in RAM, but cannot run standalone from RAM
after the programming cable is disconnected. Standalone applications can only run from
flash memory.

NOTE: Do not depend on the flash memory sector size or type. Due to the volatility of
the flash memory market, the Smart Star and Dynamic C were designed to accommo-
date flash devices with various sector sizes.

Developing software with Dynamic C is simple. Users can write, compile, and test C and
assembly code without leaving the Dynamic C development environment. Debugging
occurs while the application runs on the target. Alternatively, users can compile a program
to an image file for later loading. Dynamic C runs on PCs under Windows 95 or later. Pro-
grams can be downloaded at baud rates of up to 460,800 bps after the program compiles.
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Dynamic C has a number of standard features.

o Full-feature source and/or assembly-level debugger, no in-circuit emulator required.
¢ Royalty-free TCP/IP stack with source code and most common protocols.

e Hundreds of functions in source-code libraries and sample programs:

» Exceptionally fast support for floating-point arithmetic and transcendental functions.
» RS-232 and RS-485 serial communication.
» Analog and digital 1/O drivers.

» 12C, SPI, GPS, encryption, file system.
» LCD display and keypad drivers.
o Powerful language extensions for cooperative or preemptive multitasking

e Loader utility program to load binary images into Rabbit targets in the absence of
Dynamic C.

e Provision for customers to create their own source code libraries and augment on-line
help by creating “function description” block comments using a special format for
library functions.

e Standard debugging features:

» Breakpoints—Set breakpoints that can disable interrupts.
» Single-stepping—Step into or over functions at a source or machine code level, uC/OS-Il aware.

» Code disassembly—The disassembly window displays addresses, opcodes, mnemonics, and
machine cycle times. Switch between debugging at machine-code level and source-code level by
simply opening or closing the disassembly window.

P Watch expressions—Watch expressions are compiled when defined, so complex expressions
including function calls may be placed into watch expressions. Watch expressions can be updated
with or without stopping program execution.

» Register window—All processor registers and flags are displayed. The contents of general registers
may be modified in the window by the user.

» Stack window—shows the contents of the top of the stack.
» Hex memory dump—displays the contents of memory at any address.

» STDIO window—print£ outputs to this window and keyboard input on the host PC can be
detected for debugging purposes. print £ output may also be sent to a serial port or file.
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4.1.1 Upgrading Dynamic C
4.1.1.1 Patches and Bug Fixes

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web
site www.rabbit.com/support/ for the latest patches, workarounds, and bug fixes.

The default installation of a patch or bug fix is to install the file in a directory (folder) dif-
ferent from that of the original Dynamic C installation. Rabbit recommends using a differ-
ent directory so that you can verify the operation of the patch without overwriting the
existing Dynamic C installation. If you have made any changes to the BIOS or to libraries,
or if you have programs in the old directory (folder), make these same changes to the
BIOS or libraries in the new directory containing the patch. Do not simply copy over an
entire file since you may overwrite a bug fix. Once you are sure the new patch works
entirely to your satisfaction, you may retire the existing installation, but keep it available
to handle legacy applications.

4.1.1.2 Upgrades

Dynamic C installations are designed for use with the board they are included with, and
are included at no charge as part of our low-cost kits. Dynamic C is a complete software
development system, but does not include all the Dynamic C features. Rabbit also offers
add-on Dynamic C modules containing the popular nC/OS-I1 real-time operating system,
as well as PPP, Advanced Encryption Standard (AES), and other select libraries. In addi-
tion to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support module is also available for purchase.
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4.2 Sample Programs

Sample programs are provided in the Dynamic C samMpLES folder. The sample program
PONG . C demonstrates the output to the STDIO window. The various directories in the
saMpLES folder contain specific sample programs that illustrate the use of the correspond-
ing Dynamic C libraries.

The saMPLES\ SMRTSTAR folder provides sample programs specific to the Smart Star
control system. Each sample program has comments that describe the purpose and func-
tion of the program. Follow the instructions at the beginning of the sample program.

To run a sample program, open it with the File menu (if it is not still open), compile it using
the Compile menu, and then run it by selecting Run in the Run menu. The BL2500 must

be in Program mode (see Section 3.3, “Programming Cable”) and must be connected to a
PC using the programming cable as described in Section 2.2, “Connect the Power Supply.”

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.

Let’s take a look at sample programs for the backplane and the CPU Card in the
SMRTSTAR folder.

The rRs232 directory contains two sample programs to illustrate RS-232 serial communi-
cation.

e SSTAR232.C—Demonstrates a simple RS-232 loopback using both serial ports C and D.
e SSTARSW.C—Demonstrates simple 5-wire RS-232 communication with flow control.
The RS485 directory contains two sample programs to illustrate RS-485 serial communication.

e MASTER.C—Demonstrates a simple RS-485 transmission of lower case letters to a
slave controller. The slave will send converted upper case letters back to the master
controller for display in the STDIO window. Use SLAVE. ¢ to program the slave con-
troller.

e SLAVE.C—Demonstrates a simple RS-485 transmission of alphabetic characters to a
master controller. The slave will send converted upper case letters back to the master
controller for display in the STDIO window. Use MASTER. C to program the master
controller.
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4.3 Dynamic C Libraries
One library directory contains software that is unique to the Smart Star.

e SMRTSTAR.LIB—TNhis library supports all the functions needed by the Smart Star sys-
tems including Digital 1/0 Cards, Relay Cards, D/A Converter and A/D Converter
Cards, and serial communication.

Functions dealing with the backplane and the CPU Card are described in this chapter.
Functions relevant to the individual 1/O cards are described in the chapter specific to the
1/0 card.

Other functions applicable to all devices based on the Rabbit 2000 microprocessor are
described in the Dynamic C User’s Manual.
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4.4 Smart Star Backplane Function Calls
4.4.1 Board Reset

void brdResetBus () ;

Resets all cards on the bus.
RETURN VALUE
None.

4.4.2 Board Initialization

void brdInit () ;

Initializes slot addressing, disables card enable/disable line, resets card slot bus and LED latch, and turns
all LEDS OFF. Call this function at the beginning of the application.
RETURN VALUE

None.
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4.5 Serial Communication Calls

Library files included with Dynamic C provide a full range of serial communications support.
The Rs232.LIB library provides a set of circular-buffer-based serial functions. The
PACKET. LIB library provides packet-based serial functions where packets can be delimited
by the 9th bit, by transmission gaps, or with user-defined special characters. Both libraries
provide blocking functions, which do not return until they are finished transmitting or receiv-
ing, and nonblocking functions, which must be called repeatedly until they are finished. For
more information, see the Dynamic C Function Reference Manual and Technical Note 213,
Rabbit 2000 Serial Port Software.

Use the following function calls with the Smart Star.

int serMode (int mode) ;

User interface to set up serial communication lines for the Smart Star control system. Call this function
after serXOpen ().

PARAMETERS

mode is the defined serial port configuration of the CPU Card.

Serial Port Parallel Port
Mode
C (PC2 and PC3) D (PCO and PC1) D (PDO and PD1)
0 RS-232, 3-wire RS-485
1 RS-232, 3-wire RS-232, 3-wire
2 RS-232, 5-wire RTS/CTS
3 RS-232, 5-wire RS-485 RTS/CTS

RETURN VALUE
0 if correct mode, 1 if not.

ser485Tx () ;

Enables RS-485 transmission (disables receive) on serial port D.
RETURN VALUE
None.
SEE ALSO
ser485Rx
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Disables RS-485 transmission (enables receive) on serial port D.
RETURN VALUE
None.
SEE ALSO
ser485Tx
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5. USING THE TCP/IP FEATURES

Chapter 5 discusses using the TCP/IP features on the CPU cards.
Note that the TCP/IP feature is available only on the SR9150
CPU Card.

5.1 Ethernet Connections

Before proceeding you will need to have the following items.

e If you don’t have an Ethernet connection, you will need to install a 10Base-T Ethernet
card (available from your favorite computer supplier) in your PC.

e Two RJ-45 straight-through Ethernet cables and a hub, or an RJ-45 crossover Ethernet
cable.

The Ethernet cables and Ethernet hub are available from Rabbit in a TCP/IP tool kit. More
information is available at www.rabbit.com.

1. Install the CPU Card on the backplane, and connect the power supply and the
programming cable as shown in Chapter 2, “Getting Started.”

2. Ethernet Connections

¢ If you do not have access to an Ethernet network, use a crossover Ethernet cable to con-
nect the installed CPU Card to a PC that at least has a 10Base-T Ethernet card.

¢ If you have an Ethernet connection, use a straight-through Ethernet cable to establish
an Ethernet connection to the installed CPU Card from an Ethernet hub. These connec-
tions are shown in Figure 18.

SR9150
CPU Card SR9150
CPU Card
- | ]
User’s PC
Ethernet —— >

Ethernet cables

crossover N Ij [ 4, To additional

cable Hub v network

Direct Connection _ : ele.ments

(network of 2 computers) Direct Connection Using a Hub

Figure 18. Ethernet Connections
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3. Apply Power

Plug in the power supply. The Smart Star is now ready to be used.
NOTE: A hardware RESET is accomplished by unplugging the power supply, then plug-
ging it back in.

The green LNK light is on the CPU Card is on when the Smart Star is properly connected
either to an Ethernet hub or to an active Ethernet card. The orange ACT light flashes each
time a packet is received.
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5.2 TCP/IP Sample Programs

We have provided a number of sample programs demonstrating various uses of TCP/IP for
networking embedded systems. These programs require that you connect your PC and the
Smart Star together on the same network. This network can be a local private network
(preferred for initial experimentation and debugging), or a connection via the Internet.

5.2.1 How to Set IP Addresses in the Sample Programs

With the introduction of Dynamic C 7.30 we have taken steps to make it easier to run
many of our sample programs. You will see a TcPCONFIG macro. This macro tells
Dynamic C to select your configuration from a list of default configurations. You will
have three choices when you encounter a sample program with the TCPCONFIG macro.

1. You can replace the TcpcoNFIG macro with individual MY IP ADDRESS,
MY NETMASK, MY GATEWAY, and MY NAMESERVER Macros in each program.

2. You can leave TcPCONFIG at the usual default of 1, which will set the IP configurations
t010.10.6.100, the netmask to 255.255.255. 0, and the nameserver and gateway
t010.10.6.1. If youwould like to change the default values, for example, to use an IP
address of 10.1.1.2 for the CPU Card, and 10.1.1.1 for your PC, you can edit the
values in the section that directly follows the “General Configuration” comment in the
TCP_CONFIG.LIB library. You will find this library in the LIB\TCPIP directory.

3. You can create a CUSTOM CONFIG.LIB library and use a TCPCONFIG value greater
than 100. Instructions for doing this are at the beginning of the TcP_CONFIG.LIB
library in the LIB\TCPIP directory.

There are some other “standard” configurations for TcpcoNF1G that let you select differ-
ent features such as DHCP. Their values are documented at the top of the
TCP_CONFIG.LIB library in the LIB\TCPIP directory. More information is available in
the Dynamic C TCP/IP User’s Manual.

IP Addresses Before Dynamic C 7.30

Most of the sample programs use macros to define the IP address assigned to the CPU Card
and the IP address of the gateway, if there is a gateway. Instead of the TCPCONFIG macro,
you will see aMy IP ADDRESS macro and other macros.

#define MY IP ADDRESS "10.10.6.170"

#define MY NETMASK "255.255.255.0"

#define MY GATEWAY "10.10.6.1"
#define MY NAMESERVER "10.10.6.1"

In order to do a direct connection, the following IP addresses can be used for the CPU Card:

#define MY IP ADDRESS "10.1.1.2"

#define MY NETMASK "255.255.255.0"

// #define MY GATEWAY "10.10.6.1"

// #define MY NAMESERVER "10.10.6.1"
In this case, the gateway and nameserver are not used, and are commented out. The IP
address of the CPU Card is defined to be 10.1.1.2. The IP address of you PC can be

definedas 10.1.1.1.
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5.2.2 How to Set Up Your Computer for Direct Connect

Follow these instructions to set up your PC or notebook. Check with your administrator if
you are unable to change the settings as described here since you may need administrator
privileges. The instructions are specifically for Windows 2000, but the interface is similar
for other versions of Windows.

TIP: If you are using a PC that is already on a network, you will disconnect the PC from
that network to run these sample programs. Write down the existing settings before
changing them to facilitate restoring them when you are finished with the sample pro-
grams and reconnect your PC to the network.

. Go to the control panel (Start > Settings > Control Panel), and then double-click the

Network icon.

. Select the network interface card used for the Ethernet interface you intend to use (e.g.,

TCP/IP Xircom Credit Card Network Adapter) and click on the “Properties” button.
Depending on which version of Windows your PC is running, you may have to select
the “Local Area Connection” first, and then click on the “Properties” button to bring up
the Ethernet interface dialog. Then “Configure” your interface card for a “10Base-T
Half-Duplex” or an “Auto-Negotiation” connection on the “Advanced” tab.

NOTE: Your network interface card will likely have a different name.

. Now select the IP Address tab, and check Specify an IP Address, or select TCP/IP and

click on “Properties” to assign an IP address to your computer (this will disable “obtain
an IP address automatically”):

IP Address : 10.10.6.101
Netmask : 255.255.255.0
Default gateway : 10.10.6.1
Click <OK> or <Close> to exit the various dialog boxes.

SR9150
IP 10.10.6.101 CPU Card
Netmask
255.255.255.0
-
User’'s PC
Ethernet
crossover
cable

Direct Connection PC to Smart Star CPU Card
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5.2.3 Run the PINGME.Cc Demo

Connect the crossover cable from your computer’s Ethernet port to the CPU Card’s RJ-45
Ethernet connector. Open this sample program from the saMpLEs\TcPIP\ICMP folder,
compile the program, and start it running under Dynamic C. When the program starts run-
ning, the green LNK light on the CPU Card should be on to indicate that an Ethernet con-
nection is made. (Note: If the LNK light does not light, you may not have a crossover
cable, or if you are using a hub perhaps the power is off on the hub.)

The next step is to ping the board from your PC. This can be done by bringing up the MS-
DOS window and running the ping program:

ping 10.10.6.100
or by Start > Run

and typing the command

ping 10.10.6.100

Notice that the orange ACT light flashes on the CPU Card while the ping is taking place,
and indicates the transfer of data. The ping routine will ping the board four times and write
a summary message on the screen describing the operation.

5.2.4 Additional Demo Programs

The program sMTP.C (SAMPLES\SMRTSTAR\TCPIP\) demonstrates a basic Smart
Star system using the SMTP library to send an e-mail when a keypress is detected on an
LCD/keypad module. In order to run this sample program, edit the IP address as for the
pingme program, edit the “mail to” e-mail address, compile the program, and start it exe-
cuting. An e-mail corresponding to the keypad button that was pressed is sent.

The program ss1.c (SAMPLES\SMRTSTAR\TCPIP\) demonstrates how to make the
Smart Star CPU Card a Web server. This program allows you to turn the LEDs on an
attached LCD/keypad module on and off from a remote Web browser. In order to run these
sample programs, edit the IP address as for the pingme program, compile the program, and
start it executing. Then bring up your Web browser and enter the following server address:
http://10.1.1.2. This should bring up the Web page served by the sample program.

The program ss12.Cc (SAMPLES\SMRTSTAR\TCPIP\) demonstrates the use of 1/O
cards via instructions sent from a Web browser. You will need an A/D Converter Card, a
D/A Converter Card, or a relay card installed on the backplane in order for the Web
browser to be able to initiate changes on one or more of these 1/0 cards. Before you run
this sample program, edit the IP address as for the pingme program, compile the program,
and start it executing. The analog outputs will change or the relays will open and close in
response to instructions sent from the Web browser.

User’s Manual 55



5.2.5 LCD/Keypad Sample Programs Showing TCP/IP Features

The following sample programs, found in the TCPIP subdirectory in

SAMPLES/LCD Keypad/122x32 1x7, are demonstrate the features of the LCD/key-
pad module connected to the backplane. Remember to configure the IP address, netmask,
and gateway as indicated in the sample programs.

MBOXDEMO . C—This program implements a web server that allows Web e-mail mes-
sages to be entered that are then shown on the LCD display. The keypad allows you to
scroll within messages, flip to other e-mails, mark messages as read, and delete e-mails.
When a new e-mail arrives, an LED turns on, and turns off once the message has been
marked as read. A log of all e-mail actions is kept, and can be displayed in the Web
browser. All current e-mails can also be read with the Web browser.

When using MBOXDEMO . C, connect the Smart Star CPU Card and a PC (or other device
with a Web Browser) to an Ethernet. If you connect the PC and the CPU Card directly,
be sure to use a crossover Ethernet cable; straight-through Ethernet cables and a hub
may be used instead.

TCP_RESPOND.C—This program and TCP_SEND. C are executed on two separate sin-
gle-board computers to demonstrate how the two boards communicate with each other.
Use PCSEND . EXE on the PC console side at the command prompt if you do not have a
second board. PCSEND. EXE is located with source code in the

SAMPLES/LCD_ Keypad/Windows directory.

TCP_RESPOND. C waits for a message from another single-board computer. The mes-
sage received is displayed on the LCD, and you may respond by pressing a key on the
keypad. The response is then sent to the remote single-board computer.

TCPSEND.C—This program and TCP_RESPOND. C are executed on two separate sin-
gle-board computers to demonstrate how the two boards communicate with each other.
Use PCRESPOND . EXE on the PC console side at the command prompt if you do not
have a second board. PCRESPOND . EXE is located with source code in the
SAMPLES/LCD_ Keypad/Windows directory.

When a key on the keypad is pressed, a message associated with that key is sent to a
specified destination address and port. The destination then responds to that message.
The response is displayed on the LCD.

Note that only the LEFT and UP scroll keys are set up to cause a message to be sent.

When using TCPSEND. C and TCP_RESPOND. C, connect the CPU Card and the other
single-board computer to an Ethernet. If you connect the them directly, be sure to use a
crossover Ethernet cable; straight-through Ethernet cables and a hub may be used instead.
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5.3 Where Do | Go From Here?

NOTE: If you purchased your Smart Star through a distributor or Rabbit partner, contact
the distributor or partner first for technical support.

If there are any problems at this point:

e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Rabbit Technical Bulletin Board at www.rabbit.com/support/bb/.
e Use the Technical Support e-mail form at www.rabbit.com/support/.

If the sample programs ran fine, you are now ready to go on.
Additional sample programs are described in the Dynamic C TCP/IP User’s Manual.

Refer to the Dynamic C TCP/IP User’s Manual to develop your own applications. An
Introduction to TCP/IP provides background information on TCP/IP, and is available on
our Web site.
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6. SMART STAR SPECIFICATIONS

This chapter provides the specifications for the Smart Star back-
plane and CPU Card, and describes the conformal coating.
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Figure 19 shows the mechanical dimensions for the two Smart Star backplanes.

6.1 Electrical and Mechanical Specifications

6.1.1 Smart Star Backplane

(95)

Figure 19. Smart Star Backplane Dimensions

NOTE: All diagram and graphic measurements are in inches followed by millimeters
enclosed in parentheses.
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Table 5 lists the electrical, mechanical, and environmental specifications for the Smart

Star backplanes.

Table 5. Smart Star Backplane Specifications

Specification

Parameter
SR9010 SR9050
Board Size 6.50" x 4.20" x 0.75" 3.75" x 4.40" x 0.75"
(165 mm x 107 mm x 19 mm) (95 mm x 112 mm x 19 mm)
Connectors one 2 x 26 (CPU card slot), 2 mm | one 2 x 26 (CPU card slot), 2 mm
seven 2 x 13 (1/O card slots), 2 mm | three 2 x 13 (1/O card slots), 2 mm
Each slot has a predefined dedicated set of addresses
Slot Select (see Appendix D and the software chapters in the
individual 1/0 card manuals)
Temperature —40°C to +70°C
Humidity 5% to 95%, noncondensing

External Input Voltage

9V to30V DC at 1A typical for onboard +5 V regulated supply;
provision for independent 9 V to 30 V DC (V_USER) voltage source for
1/0 cards—the exact voltage for the second supply depends on the
requirements of the specific 1/O cards used (Rabbit recommends tying
V_USER to +RAW unless there is a specific need for an independent

power supply)

Onboard Voltage Regulator

Surface-mount switching regulator sources 5V at1 A

Data Lines

Buffered bidrirectional data lines (D0-D7)

Address Lines

Buffered address lines (A0-A3)

Read/Write Control

Buffered IORD, IOWR

Reset

1/0 cards and CPU card can be reset independently
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6.1.2 CPU Card
Figure 20 shows the mechanical dimensions for the CPU cards.

< 138
(35.0)

oW aN
) o
N© o
A
‘ ‘ 05
3.53 . S
: (89.7)
4.00
(102)

Figure 20. CPU Card Dimensions
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Table 6 lists the electrical, mechanical, and environmental specifications for the CPU
Card.

Table 6. CPU Card Specifications

Parameter

Specification

Board Size (with optional

backup battery board)

4.00" x 3.12" x 1.00"
(102 mm x 79.2 mm x 25.4 mm)

Connectors

one RJ-45 (Ethernet) (SR9150 only)

one 2 x 5, 2 mm pitch (serial programming port)

one 0.9 mm x 0.5 screw-terminal connector strips (accept 14—
30 AWG or 0.05-1.5 mm?2 wire)

Ethernet Interface
(SR9150 only)

Direct connection to 10/100-compatible Ethernet networks
with 10Base-T interface via RJ-45 connection

Temperature —40°C to +70°C
Humidity 5% to 95%, noncondensing
Input Voltage 5V DC at 190 mA typical
Microprocessor Rabbit 2000®
Clock 22.1 MHz
SRAM 128K, surface mounted, 512K option
Flash EPROM 2 x 256K, surface mounted
. Five 8-bit timers cascadable in pairs, one 10-bit timer with 2
Timers . .
match registers that each have an interrupt
Three serial ports:
« one CMOS-compatible programming port
Serial Ports « remaining ports software-configurable as two 3-wire RS-
232, one 5-wire RS-232, or one 3-wire RS-232/
one RS-485
Selected baud rates up to 115, 200 bps
Serial Rate CMOS-compatible port supports up to 6.45 Mbps
(synchronous)
Watchdog/Supervisor Yes
Time/Date Clock Yes

Expansion Port

Supports up to 7 1/0 cards

Backup Battery

Yes: Panasonic CR2330 or equivalent 3 V lithium coin type,
265 mA-h standard using onboard battery holder;
provision for external battery
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6.2 Jumper Configurations

Figure 21 shows the header locations used to configure the various CPU Card options via

jumpers.
SRERERE) R

JP1

0O

)-

O Battery
[ _

-

&)
&%)
JP5 o
— JP3
1 P2
JP4 %

Figure 21. Location of Smart Star CPU Card Configurable Positions
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Table 7 lists the configuration options.

Table 7. Smart Star CPU Card Jumper Configurations

Header Description Pins Connected Factory
Default
1-2 | Bias and termination resistors %
. N 5-6 | connected
P1 RS-485 Bias and Termination
Resistors 1-3 | Bias and termination resistors not
4-6 | connected”
1-2 | 128K/256K X
JP2 U5 Flash Memory Size
2-3 |512K
1-2 128K X
JP3 SRAM Size
2-3 |512K
1-2 | 128K/256K X
JP4 | U1l Flash Memory Size
2-3 |512K
1-2 | Normal Mode X
JP5 Flash Memory Bank Select
2-3 |Bank Mode

* Although pins 1-3 and 4-6 of header JP1 are shown “jumpered” for the termination and
bias resistors not connected, pins 3 and 4 are not actually connected to anything, and this
configuration is a “parking” configuration for the jumpers so that they will be readily

available should you need to enable the termination and bias resistors in the future.
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6.3 Conformal Coating

The areas around the crystal oscillator and the battery backup circuit on the CPU Card
have had the Dow Corning silicone-based 1-2620 conformal coating applied. The confor-
mally coated areas are shown in Figure 22. The conformal coating protects these high-
impedance circuits from the effects of moisture and contaminants over time.

Conformally
coated area

Figure 22. CPU Card Areas Receiving Conformal Coating

Any components in the conformally coated area may be replaced using standard soldering
procedures for surface-mounted components. A new conformal coating should then be
applied to offer continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Rabbit Technical Note
TN303, Conformal Coatings.
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6.4 Use of Rabbit 2000 Parallel Ports
Figure 23 shows the Rabbit 2000 parallel ports.

PB2— PB6
PB5 PB7

1

PEO PE3
PE1 PE7

11

‘ PDO-PD4

Port B Port E
Serial Port
PCO, PC2, PC4 Serial Ports CPU Control
(Port C) (RABBIT 2000™) (Port D)
PC1, PC3, PC5
Z-Bus Reset

~ PD7

PC6-PC7 {amm|

DAO-DA7 ﬁ

| Real-Time Clock |

Prog;ammi"g Address Lines A0-A3
ort
Watchdog IORD
. 6 Timers 1/0 Control IOWR
Data Lines
| Clock Doubler |[™ Misc. Input__|dmmmm RESET
RAM Backup Battery Flash

Support

Figure 23. Smart Star CPU Card Rabbit 2000 Systems
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6.5 Exclusion Zone

It is recommended that you allow for an “exclusion zone” of 3" (80 mm) around the Smart
Star in all directions when the Smart Star is incorporated into an assembly that includes
other components. This “exclusion zone” that you keep free of other components and
boards will allow for sufficient air flow, and will help to minimize any electrical or EMI
interference between adjacent boards.
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PART Il. DIGITAL 1/O0 CARDS
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7. DIGITAL I/O CARDS

Chapter 7 describes the features of the Digital 1/0 Card, one of
the 1/O cards designed for the Smart Star embedded control sys-
tem.The Smart Star is a modular and expandable embedded con-
trol system whose configuration of 1/0, A/D Converter, D/A
Converter, and Relay Cards can be tailored to a large variety of
demanding real-time control and data acquisition applications.

The typical Smart Star system consists of a rugged backplane with a power supply, a CPU
card, and one or more 1/O cards. The CPU Card plugs into a designated slot on the back-
plane chassis, which has seven additional slots available for I/O cards to be used in any
combination. A high-performance Rabbit 2000 microprocessor on the CPU Card provides
fast data processing.

7.1 Features

The SR9200 Digital 1/0 Cards offer protected digital inputs and high-current driver out-
puts in three banks, each containing 8 1/0 points. One bank’s configuration is fixed as pro-
tected digital inputs, one bank’s configuration is fixed as high-current driver outputs, and
one bank may be configured either as protected digital inputs or as high-current driver out-
puts, depending on the model of Digital 1/O Card selected. The high-current driver outputs
are either all sinking or all sourcing, depending on the model of Digital I/0O Card selected.

Table 8 lists the Digital 1/0 Cards that are available for the Smart Star control system.

Table 8. Smart Star Digital /O Cards

1/0O Card Model Features

SR9200 16 digital inputs, 8 digital sinking outputs

SR9210 8 digital inputs, 16 digital sinking outputs

SR9220 8 digital inputs, 8 digital sinking outputs
Digital 1/0

SR9205 16 digital inputs, 8 digital sourcing outputs

SR9215 8 digital inputs, 16 digital sourcing outputs

SR9225 8 digital inputs, 8 digital sourcing outputs
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7.2 User Interface

Figure 24 shows the complete pinout for the user interface on header J2. Note that pin 1 is

indicated by a small arrow on the ribbon cable connector.

GND
DIGIN1
DIGIN3
K
DIGINS
DIGIN7
1/08
11010
GND
11013
11015
HVOUT1
GND
HVOUT4
HVOUTS
HVOU7

GND

o
N

o o O 0o o 0O o o o g o o O o oo’

o a a a [m) [m) [m) [m) [m) [m) o o [m) [m) [m) [m) [m)

DIGINO
DIGIN2
GND
DIGIN4
DIGING
GND
1109
11011
11012
11014
HVOUTO
HVOUT2
HVOUT3
K
HVOUT6

Figure 24. Digital /0 Card User Interface Pinout
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7.3 User FWT Connections

Connections to the Digital 1/0 Cards are made via a ribbon cable connector or optional
field wiring terminals that are either pluggable or have screw terminals. Table 9 lists the
Rabbit part numbers for the FWTs.

Table 9. Guide to FWT Selection

Rabbit Part Number

Pluggable Terminals Screw Terminals
FWT Description I/O Cards
FwWT27 Digital I/0 101-0420 101-0514
7.3.1 Pinouts
Figure 25 shows the pinout for FWT27s used on 1ToNenD
Digital 1/0 Cards. Note that only 23 of the 1/O 2||2|[piGIN0
points are available on the FWT27—the HVOUT?7 j g g:g:z;
digital output is not available on the FWT27. sllolloicing
6||D||K
7[| @[ DIGINg
8||@||DIGINS
9|(D||DIGING
m 010||@|[DIGIN7
8811||@|f1os
3812||@|f o9
a613||@|[ro10
§§14 O |fro11
0015||@|[ 11012
(o)}
8816 Olfo13
9017||@|[ 11014
0018||D|f1o15
19|(@[|HvoUTO
20|(@||[HvoUT1
21||@[|HvouUT2
22(|@{|HvouTs
23|(@||HvouT4
24| D[
25(|@|[HvouUTS
26||@[|HvOUTE
27|(@|llGND
Figure 25. FWT Pinout for
Digital I/O Cards
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7.4 Digital Inputs and Outputs

The Digital 1/0 Card has 24 1/0 points that are factory configured as either inputs or outputs
in banks of eight, depending on the model.

Figure 26 shows the locations of the 1/0 banks.
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e 0000000000000
0 W 000000000000m
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Figure 26. Locations of Banks
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The 1/0 points on Bank 0 are always inputs, and the 1/0 points on Bank 1 are always out-
puts. The I/O points on Bank 2 were configured at the factory as either inputs or outputs,
depending on the model of the Digital 1/0 Card. Table 10 lists the factory configurations.

Table 10. Digital I/0O Card Bank 2
Factory Configurations

Model Bank 2 Configured As
SR9200 Inputs

SR9210 Sinking outputs
SR9220 —

SR9205 Inputs

SR9215 Sourcing outputs
SR9225 —

The operation of Bank 2 is determined by the components on the Digital I/O Card. There
IS no jumper setting to select between inputs and outputs for Bank 2.

7.4.1 Digital Inputs

Table 11 provides the pinout configuration for the input points.

Table 11. Digital Inputs Pinout

Pin Bank O Pin Bank 2
2 DIGINO INO 13 1/08 IN8
3 DIGIN1 IN1 14 1/09 IN9
4 DIGIN2 IN2 15 1/010 IN10
5 DIGIN3 IN3 16 1/011 IN11
8 DIGIN4 IN4 18 1/012 IN12
9 DIGIN5S IN5 19 1/013 IN13
10 DIGING ING 20 1/014 IN14
11 DIGIN7 IN7 21 /015 IN15
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The protected digital inputs, shown in Figure 27, are factory configured with 10 kQ pull-
up resistors. Digital 1/O cards are also available in quantity with the protected digital
inputs pulled down as shown in Figure 27.

INPUT PULLED UP () sy

Vce
10 kQ
22 k2 74HC257
DIGIN | MULTIPLEXER 4» CPU card

10 nF

1

INPUT PULLED DOWN

22k 74HC257
DIGIN i MULTIPLEXER ’ CPU card
10 kQ 10 nF

I

Figure 27. Protected Digital Inputs

A 0 Q surface-mount resistor is used as a jumper to select whether the inputs are pulled up
or down, as shown in Figure 28.

SINKING OUTPUTS SOURCING OUTPUTS
S~ ! So 1 o 1 e g 1
:&Hg INPUTS m%@g INPUTS :&Hﬁ INPUTS m‘—‘:ai INPUTS
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=T . ™1 DOWN = . 1 DOWN
22 F ER2 £8 F 82
32| |3 Dotault C K] a” Dottt LR
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E% E_]JEEE ] i {mjim nn |
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OElE FaEinn %gg@@@ gaﬂg

@ﬁ| ﬁgfﬁﬁﬁf 2z =
Hl EPACIET E
Hd P 8883200888888 FAARAARRARAAY =

PUTDDTODIRED |
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Figure 28. Selecting Pulled Up or Pulled Down Digital Inputs

The digital inputs are able to operate continuously from -30 V to +30 V, and have a logic
threshold of 2.5 V. They are protected against spikes up to +48 V.
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7.4.2 Digital Outputs

The high-current digital outputs are either sinking or sourcing, depending on the model of
the Digital 1/0 Card. Table 12 provides the pinout configuration for the output points.

Table 12. Digital Outputs Pinout

Pin Bank 2 Pin Bank 1
13 1/08 ouTs 22 HVOUTO ouTo
14 1/09 ouT9 23 HVOUT1 ouUT1
15 1/010 OuUT10 24 HVOUT2 ouT2
16 1/011 OuUT11 26 HVOUT3 OouUT3
18 1/012 OUT12 27 HVOUT4 ouT4
19 1/013 OuUT13 29 HVOUT5 ouT5
20 1/014 OUT14 30 HVOUT6 ouUT6
21 1/015 OUT15 31 HVOUT? ouT7
Figure 29 shows the power distribution on the Digital 1/0O Card.
BACKPLANE USER INTER-
SLO_T 0-6 FACE (J2)
20 5V MulLtg)tlcel;(er/ K 7 28
JP1 or JP3 FPWR
22 +V_USER
|3
51 , +RAW
1,25 1,6, 12,17, 25, 33
. i B

Figure 29. Digital I/O Card Power Distribution

When designing your interface with the Smart Star system, you need to establish whether
you will use the +V_USER/+RAW supply on the backplane or your own independent K
supply to drive the high-current outputs. The selection of this FPWR power supply is
implemented via a 0 Q surface-mount resistor on header JP1 (sinking outputs) or header

JP3 (sourcing outputs) as shown in Figure 30. The factory default is to use

+V_USER/+RAW, but Digital I/0 Cards are available in quantity with the FPWR power

supply jumpered to your own independent K supply.
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Figure 30. Selecting Power Supply for High-Current Sinking or Sourcing Outputs

Figure 31 shows how to connect a load to the high-current outputs based on whether your
Digital 1/0 Card model has sinking or sourcing outputs.

SINKING OUTPUT SOURCING OUTPUT
FPWR Load FPWR
HvVOUT ] e ‘ HVOUT
536 O 1KkQ 100 nF —— Load
CPU card I100 nF CPU card

Figure 31. Connecting a Load to the High-Current Outputs

Each high-current output is able to sink or source up to 200 mA continuously, with a load
limit of 40 V. Each high-current output may be switched independently, or a whole bank
may be switched at once. The total current draw should be kept below 2.0 A when all
high-current outputs on one Digital I/0O Card are operating simultaneously, and the total
current draw from your +V_USER/+RAW supply for all the 1/O cards should be kept
below 7.0 A.

NOTE: Note that the power supply provided in the Smart Star Tool Kit has a maxi-
mum output of 1.1 A.
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7.5 Software
7.5.1 Sample Programs

e SSTARIO.C—Demonstrates digital I/0 using individual channels and whole banks. The
sample program is set up for 8 inputs and 16 outputs. If necessary, you may change the
macros in the sample program to match your Digital 1/O Card.

7.5.1.1 Running Sample Programs

To run a sample program, open it with the File menu (if it is not still open), compile it
using the Compile menu, and then run it by selecting Run in the Run menu. The CPU
Card must be connected to a PC using the programming cable as described in Section 2.3,
“Programming Cable Connections.”

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
7.5.2 Dynamic C Libraries

The SMRTSTAR directory contains libraries required to operate the Smart Star control
system.

e SMRTSTAR.LIB—This library supports all the functions needed by the Smart Star sys-
tems including Digital 1/0 Cards, Relay Cards, D/A Converter and A/D Converter
Cards, and serial communication.

Other functions applicable to all devices based on the Rabbit 2000 microprocessor are
described in the Dynamic C Function Reference Manual.
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7.5.3 Smart Star Digital 1/0 Card Function Calls

int digIn(int channel) ;

Reads the state of a digital input channel (INO-IN15, IN8-IN15 is not available on all versions of the
Digital 1/0 Card).

PARAMETER
channel is the digital input channel to read. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-15.
RETURN VALUE
The state of the digital input channel, 0 or 1.
SEE ALSO
digBankIn, digOut, digBankOut

int digBankIn(int bank) ;

Reads the state of Bank 0 or Bank 2 (if installed) digital input channels—Bank 0 consists of INO-IN7
and Bank 2 consists of IN8—IN15.

PARAMETER
bank is the bank of digital input channels to read. bank should be passed as
bank = (slotnumber * 16) + (banknumber)
or

bank BankAddr (slotnumber, banknumber)

where slotnumber is 0-6, and banknumber is 0 or 2.
RETURN VALUE
An input value in the lower byte, where each bit corresponds to one channel.
SEE ALSO
digIn, digOut, digBankOut
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void digOut (int channel, int wvalue);
Writes a value to an output channel (OUT0-OUT15, OUT8-IN15 not available on all versions of the
Digital 1/0O Card).
PARAMETERS
channel is the digital output channel to write. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
or
channel = ChanAddr (slotnumber, channelnumber)

where slotnumber is 0-6, and channelnumber is 0-15.

value is the output value, 0 or 1.
RETURN VALUE

None.
SEE ALSO

digBankOut, digIn, digBankIn

int digBankOut (int bank, int value);

Writes a byte value to Bank 1 or Bank 2 (if installed) digital output channels—Bank 1 consists of OUTO0-
OUT?7 and Bank 2 consists of OUT8-OUT15.

PARAMETER
bank is the bank of digital output channels to write. bank should be passed as
bank = (slotnumber * 16) + (banknumber)
or
bank = BankAddr (slotnumber, banknumber)
where slotnumber is 0-6, and banknumber is 1 or 2.
value is the output value, where each bit corresponds to one channel.
RETURN VALUE
An input value in the lower byte, where each bit corresponds to one channel.
SEE ALSO
digOut, digIn, digBankIn
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7.6 Electrical and Mechanical Specifications
Figure 32 shows the mechanical dimensions for the Digital 1/0 Card.

o —~
<t N~
NS

Nv

| —"

Figure 32. Digital I/O Card Dimensions

NOTE: All diagram and graphic measurements are in inches followed by millimeters
enclosed in parentheses.
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Table 13 lists the electrical, mechanical, and environmental specifications for the Digital

1/0O Card.
Table 13. Digital I/O Card Specifications
Parameter Specification
. 2.73" x 3.00" x 0.44"
Board Size (70 mm x 76 mm x 11 mm)
Connectors one 2 x 17 latch/eject ribbon connector, 0.1 inch pitch

Operating Temperature

—40°C to +70°C

Humidity

5% to 95%, noncondensing

Power Requirements

5V DC at 65 mA from backplane (+5 V supply)

9V to 30V DC for +RAW/+V_USER from backplane or 9 V
to 30 V DC for K on user interface header J2

Maximum draw 2.0 A from +RAW/+V_USER on backplane

Digital Inputs

Continuous operation from -30 V to +30 V, logic threshold at
2.5V, protected against spikes +48 V, 10 kQ pull-up/pull-down
resistors

Digital Outputs

Each output can sink (source) up to 200 mA continuously with
load limit of 40 V, each output may be switched independently
or bank of eight may be switched all at once, load current
supplied from +RAW/+V_USER on backplane or user-
supplied K on user interface header J2
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PART Ill. A/D CONVERTER CARDS
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8. A/D CONVERTER CARDS

Chapter 8 describes the features of the A/D Converter Card, one
of the 1/O cards designed for the Smart Star embedded control
system.

The Smart Star is a modular and expandable embedded control system whose configura-
tion of 1/0, A/D Converter, D/A Converter, and Relay Cards can be tailored to a large
variety of demanding real-time control and data acquisition applications.

The typical Smart Star system consists of a rugged backplane with a power supply, a CPU
card, and one or more 1/O cards. The CPU card plugs into a designated slot on the back-
plane chassis, which has seven additional slots available for I/O cards to be used in any
combination. A high-performance Rabbit 2000 microprocessor on the CPU card provides
fast data processing.

8.1 A/D Converter Card Features

Three models of A/D Converter Cards are available, as shown in Table 14.

Table 14. Smart Star A/D Converter Cards

I/0O Card Model Features

SR9300 12-bit A/D converter, 11 channels, 0 V - 10 V

A/D Converter SR9310 12-bit A/D converter, 11 channels, -10 V — +10 V

SR9320 12-bit A/D converter, 11 channels, 4 mA - 20 mA
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8.2 User Interface

Figure 33 shows the circuit used to condition the analog signal before it goes to the A/D
converter chip. Depending on the model of A/D Converter Card you have, it is designed to
handle analog inputs of 0 V to 10 V, -10 V to +10 V, or 4-20 mA. The two different volt-
age ranges are handled with different gain resistors, Ry: 23.7 k€2 for the SR9300 and

12.1 kQ for the SR9310. The input shown in Figure 33 is configured differently for the
SR9320, which handles analog inputs of 4-20 mA.

Ces
I
1l
1nF
Rg
o sWva
Input Rin
m— Vv - To ADC
100 kQ ——
+
VREF ReotTom

Figure 33. Analog Input Amplifier Circuit

The TLC2543 A/D converter chip on the A/D Converter Card uses synchronous Serial Port
B and Timer A5 on the Rabbit 2000 to do the A/D conversions.

Figure 34 shows the complete pinout for the user interface on header J2. Note that pin 1 is
indicated by a small arrow on the ribbon cable connector.

J2
AINO [m o | AINT
GND| o o]|AIN2 L
pov B e S5993RR595% =
AIN4 | o o |AIN5
GND |2 o|AIN6
GND |0 o |AIN7
AIN8| o o |GND
AIN9 | o © [AIN1O
GND|o o|+5V (ADC)
GND |0 o|+25V

Figure 34. A/D Converter Card User Interface Pinout
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8.3 User FWT Connections

Connections to the A/D Converter Cards are made via a ribbon cable connector or
optional field wiring terminals that are either pluggable or have screw terminals. Table 15
lists the Rabbit part numbers for the FWTs.

Table 15. Guide to FWT Selection

FWT Description

I/0O Cards

Rabbit Part Number

Pluggable Terminals Screw Terminals

FWT18

A/D Converter

101-0421 101-0515

8.3.1 Pinouts

Figure 35 shows the pinout for the FWTs used on

the A/D Converter Cards.

1[[oflano
2[lo[lAINT
3|l |lenD
4|[o|lAaN2
5||@[|AIN3
6||@||eND
7|[@||AIN4
8|[o|lAIN5
9||@||eND

= ¢10]|@]|AING

s211||olleND

so12|lp[lAN7

S 213||o[laiNs

e e14|[®||cND

5515 ||ANg

e 16/|D|{AIN10

ee17(@||+5V (ADC)

e e18|(D||+2.5 Vv (ADC)

Figure 35. FWT Pinout for
A/D Converter Cards
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8.4 Power Distribution

Figure 36 shows the power distribution on the A/D Converter Card.

BACKPLANE
SLOT 0-6

20

+5V

Multiplexer/

22 +V_USER

Latch

+5V VecADC

1,26

L

Precision
+2.5 V reference

Figure 36. A/D Converter Card Power Distribution
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8.5 Software
8.5.1 Sample Programs

e SSTARAD1.C—Demonstrates how to calibrate an A/D converter channel using two
known voltages, and defines the two coefficients, gain and offset. These coefficients are
then read back to compute the equivalent voltage.

e SSTARAD2.C—Reads and displays voltage and equivalent values of each A/D converter
channel. Calibrations must have been previously stored into flash memory before run-
ning this program. See sample program SSTARAD3 . C.

e SSTARAD3.C—Demonstrates how to calibrate all A/D converter channels using two
known voltages and defines the two coefficients, gain and offset. These coefficients are
then read back to compute the equivalent voltage and are saved to flash memory.

8.5.1.1 Running Sample Programs

To run a sample program, open it with the File menu (if it is not still open), compile it
using the Compile menu, and then run it by selecting Run in the Run menu. The CPU
Card must be connected to a PC using the programming cable as described in Section 2.3,
“Programming Cable Connections.”

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
8.5.2 Dynamic C Libraries

The SMRTSTAR directory contains libraries required to operate the Smart Star control

system.

e SMRTSTAR.LIB—This library supports all the functions needed by the Smart Star sys-
tems including Digital 1/0 Cards, Relay Cards, D/A Converter and A/D Converter
Cards, and serial communication.

Other functions applicable to all devices based on the Rabbit 2000 microprocessor are
described in the Dynamic C Function Reference Manual.
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8.5.3 Smart Star A/D Converter Card Function Calls

int anaInEERd (int channel) ;

The A/D Converter Card calibration constants, gain, and offset are stored in the factory in the upper half
of the EEPROM on the A/D Converter Card. Use this function to read the A/D Converter Card calibra-
tion constants, gain, and offset from the upper half of the EEPROM on the A/D Converter Card.

PARAMETERS
channel is the analog input channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10.
RETURN VALUE

0 if successful.
-1—control command unacceptable.
-2—EEPROM address unacceptable.

SEE ALSO

anaInEEWr

int anaSaveCalib () ;

The calibration constants may also be saved in the flash memory on the Smart Star CPU Card. Doing so
will speed up A/D conversions since a memory access from flash memory will be faster than from
EEPROM. Use anaSaveCalib to save the current set of calibration constants for the analog input and
output channels in the Smart Star flash memory. The calibration constants stored in flash memory can
then be accessed at any time with the anaLoadCalib function.

If the factory-set calibration are not used, customer-measured calibration constants should first be estab-
lished using the anaInCalib function.

RETURN VALUE
None.
SEE ALSO

anal.oadCalib, anaInCalib

void anal.oadCalib () ;

Reads a complete set of calibration constants for the analog input and output channels from the Smart
Star flash memory on the CPU Card. These should be set using the anaInCalib or anaInEERA func-
tion, then saved to flash memory using the anaSaveCalib function.

RETURN VALUE
None.
SEE ALSO

anaSaveCalib, anaInCalib
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int anaInCalib(int channel, int wvaluel,
float voltl, int wvalue2, float wvolt2);

Used to recalibrate the response of the A/D converter channel as a linear function using the two conver-
sion points provided. Gain and offset constants are calculated and placed into the global table
_adcCalib.

PARAMETERS

channel is the A/D converter input channel (0-10). channel should be passed as
channel = (slotnumber * 128) + (channelnumber)

where slotnumber is 0-6, and channelnumber is 0-10

or
channel = ChanAddr (slotnumber, channelnumber)

where slotnumber is 0-6, and channelnumber is 0-10.

valuel is the first A/D converter value.

voltl is the voltage/current corresponding to the first A/D converter value. Current values entered as
milliamps will produce milliamp values, and amp values entered will produce amp values.

value2 is the second A/D converter value.

volt2 is the voltage/current corresponding to the second A/D converter value. Current values entered
as milliamps will produce milliamp values, and amp values entered will produce amp values.

RETURN VALUE

0 if successful,
-1, if not able to make calibration constants.

SEE ALSO

analIn, analInVolts

int anaInEEWr (int channel) ;

Writes the calibration constants, gain, and offset to the upper half of the EEPROM on the A/D Converter
Card.

PARAMETERS
channel is the analog input channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10.
RETURN VALUE

0 if successful.
-1—control command unacceptable.
-2—EEPROM address unacceptable.
-3—data value unacceptable.

SEE ALSO

anaInEERd, anaInEEWr

User’s Manual 93



unsigned int anaIn(unsigned int channel) ;
Reads the state of an analog input channel and converts it to a digital value. A timeout occurs, causing
the function to exit, if the end of the conversion is not detected within 13 ps.
PARAMETERS
channel is the analog input channel to read. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10.
RETURN VALUE

A value corresponding to the voltage on the analog input channel, 0-4095. A value outside this range
indicates a failure

SEE ALSO

anaInCalib, anaInVolts

int anaInVolts (int channel);

Reads the state of an analog input channel and uses the previously set calibration constants to convert the
state to volts.

PARAMETERS
channel is the analog input channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10.
RETURN VALUE

A voltage value corresponding to the voltage on the analog input channel (0—+10 V on the SR9300 or
-10-+10 V on the SR9310).

SEE ALSO

analIn, anaInCalib, anaInmAmps
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float anaInmAmps (unsigned int channel) ;

Reads the state of an analog input channel and uses the previously set calibration constants to convert the
state to current.
NOTE: The factory-set calibration constants are for current measurements in amperes.
PARAMETERS
channel is the analog input channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-10.
RETURN VALUE
A current value corresponding to the 4-20 mA (0.004-0.020 A) current on the analog input channel.
SEE ALSO

anaIn, anaInCalib, anaInVolts
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8.6 Electrical and Mechanical Specifications
Figure 37 shows the mechanical dimensions for the A/D Converter Card.

o~
<3 0~
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Figure 37. Relay Card Dimensions

NOTE: All diagram and graphic measurements are in inches followed by millimeters
enclosed in parentheses.
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Table 16 lists the electrical, mechanical, and environmental specifications for the A/D

Converter Card.

Table 16. A/D Converter Card Specifications

Parameter Specification
. 2.73" x 3.00" x 0.44"
Board Size (70 mm x 76 mm x 11 mm)
Connectors one 2 x 10 latch/eject ribbon connector, 0.1 inch pitch

Operating Temperature

—40°C to +70°C

Humidity

5% to 95%, noncondensing

Power Requirements

5V DC at 40 mA from backplane (+5 V supply)

9V to30V DC,35mAat 24V DC, +RAW/+V_USER from
backplane

Number of Inputs

11 conditioned channels

Analog Input Ranges”

0V to +10 V (max. £22 V DC)
-10 V to +10 V (max. 40 V DC)
4 mA to 20 mA (max. 30 mA)

Resolution

12 bits (0-4095)

Conversion Time
(including Dynamic C)

0.13 ms/channel (includes 0.08 ms/channel for raw count)

Repeatability

Typical £% count, maximum £1 count @ —20°C to +70°C
Typical £1 count, maximum 2 counts @ —40°C to —20°C

Accuracy

Typical £1 count, maximum %2 counts @ 25°C
+4 counts @ —40°C and +70°CT

Input Impedance

SR9300 (0 V to +10 V): 100 k2 min.
SR9310 (-10 V to +10 V): 100 kQ min.
SR9320 (4 mA to 20 mA): 249 Q + 1%

Linearity Error (end to end)

+1 count

* The A/D Converter Card is protected against transients that might exceed the maxi-

mum ratings.

t Accuracy at temperature extremes can be improved by recalibrating the A/D Converter
Card at the temperature it will be used at.
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9. D/A CONVERTER CARDS

Chapter 9 describes the features of the D/A Converter Card, one
of the 1/O cards designed for the Smart Star embedded control
system.

The Smart Star is a modular and expandable embedded control system whose configura-
tion of 1/0, A/D Converter, D/A Converter, and Relay Cards can be tailored to a large
variety of demanding real-time control and data acquisition applications.

The typical Smart Star system consists of a rugged backplane with a power supply, a CPU
card, and one or more 1/O cards. The CPU card plugs into a designated slot on the back-
plane chassis, which has seven additional slots available for I/O cards to be used in any
combination. A high-performance Rabbit 2000 microprocessor on the CPU card provides
fast data processing.

9.1 D/A Converter Card Features

Three models of D/A Converter Cards are available, as shown in Table 17.

Table 17. Smart Star D/A Converter Cards

I/0O Card Model Features

SR9400 12-bit D/A converter, 8 channels, 0 V - 10 V

D/A Converter SR9410 12-bit D/A converter, 8 channels, -10 V — +10 V

SR9420 12-bit D/A converter, 8 channels, 4 mA — 20 mA
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9.2 User Interface

Figure 38 shows the D/A converter circuit. A buffer, U6, buffers the data signals DO-D7
from the Smart Star backplane, and sends them to the D/A converter, U2-U5. Signals D2—
D5 are used to switch the chip select line to identify which D/A converter will perform the
conversion. The model of D/A Converter Card determines the analog output ranges (0 V to
10V, -10 Vto +10 V, or 4-20 mA). The different voltage or current ranges are handled with
different feedback resistors, as shown in Figure 38. A switching regulator provides a regu-
lated power supply for the op-amps.

33 pF
-
SR9400/SR9410 H
Y 825 kQ
—— AN D/A_SEN[0-7]
u2-Us
DA_DATA —{on DAC 165 kO U10
DA _CLK —{SCLK  OUT [——AAN———4
—/cs
100 Q
1
00
b D/A_OUT[0-7]
33 pF
I
SR9420 "
Y ! 8.25 kQ
u2-Us
DA _DATA —bin  DAC 165 kQ u10 0Q
DA CLK —{sctk  out AN =
- —] ics 100
165 kQ
L +
D/A_OUT[0-7]
8.25 kQ

Figure 38. D/A Converter Card Circuit

NOTE: The D/A_SEN[0-7] sensing inputs are not used when using the current source
version (model SR9420) of the D/A Converter Card.
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Figure 39 shows the complete pinout for the user interface on header J1. Note that pin 1 is
indicated by a small arrow on the ribbon cable connector.

J1

D/A_SENO [m ©o|D/A_OUTO
D/A_SEN1|c o|D/A_OUT1
D/A_SEN2 | o o|GND -ggg ggggo @
D/A_SEN3|o o |D/A_OUT2
D/A_SEN4 o o | D/A_OUT3

AGND | o o |D/A_OUT4
D/A_SEN5| o ©o|D/A_OUTS
D/A_SEN6 o © | D/A_OUT6

AGND [& = |D/A_OUT7

AGND | @ © | D/A_SEN7

P|n1

Figure 39. D/A Converter Card User Interface Pinout

The D/A Converter Card has eight analog output channels, D/A_OUT[0-7], and is also
equipped with a remote sensing capability through sensing inputs D/A_SEN[0-7] for the
voltage-amplifier versions of the D/A Converter Card (models SR9400 and SR9410).
These sensing inputs compensate for the voltage drop across the wire leads of low-impedance
loads to provide a more precise output across the load.

Let’s look at Figure 40 to see how this happens. Assume the load is 500 Q. If the imped-
ance of the wire used to connect the load to the output terminal on the D/A Converter Card
is 5 Q there will be a voltage drop of about 5 Q/500 € = 1% across the wire. The voltage
across the load will then be 1% less, which is about 40 counts for the SR9400. By connect-
ing D/A_SEN as shown in Figure 40, the output driver will be able to sense the voltage
drop across the wire and provide a more accurate voltage output across the load. If the
load impedance is much greater than the impedance of the wire leads, simply leave the
D/A_SEN sensing inputs open.

33 pF

Il
825 kQ

> DIA_SEN[0-7]

u10

<

1000 S50

>
D/A_OUT[0-7]
%500 Q

Figure 40. D/A Converter Output for Low-Impedance Loads
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9.3 User FWT Connections

Connections to the D/A Converter Cards are made via a ribbon cable connector or
optional field wiring terminals that are either pluggable or have screw terminals. Table 18
lists the Rabbit part numbers for the FWTs.

FWT Description I/O Cards
FWT18 D/A Converter 101-0421 101-0515
9.3.1 Pinouts

Figure 41 shows the pinout for the FWTs used on
the D/A Converter Cards.

Table 18. Guide to FWT Selection

Rabbit Part Number

Pluggable Terminals Screw Terminals

1[o]o/a_seno
2||@||o/Aa_ouTo
3||@||D/A_SEN1
4||o||p/Aa_ouT1
5/(@||D/A_SEN2
6||@||eND
7|[@|lo/A_SEN3
8||@||p/A_ouT2
9||@||p/A_SEN4
2 ¢10|[@]|D/A OUT3
eo11||ollenD
e o12|[@|lp/A_ouTa
e 213||o|lp/A_seNs
e o14||®||p/A_ouTs
5515 o|lo/a_sene
::16 O||Db/A_OUT6
ee17|[®|lD/A OUT?
[ X ]
ee18||D||D/A_SENT

Figure 41. FWT Pinout for
D/A Converter Cards

104

Smart Star D/A Converter Cards (SR9400)



9.4 Power Distribution

Figure 42 shows the power distribution on the D/A Converter Card.

BACKPLANE
SLOT 0-6
— Multiplexer/
2 +5V Latch
+4.096 V
DAC reference
22 +V_USER +12 V voltage
regulators
1,26
[ L

Figure 42. D/A Converter Card Power Distribution

Figure 43 shows the power supply for the op-amps used as voltage amplifiers/current
sources.

U1
+12 V Reg [———OFF/ON control

+V_USERT IN GNDOUT —+12V
T | I

U9
SR9410 -12V Reg

only _T_ IN GNDOUTﬁ
T T -12V

Figure 43. Op-Amp Power Supplies

There is provision in software using the anaOutDisable Or the anaOutEnable func-
tion calls to turn the regulated £12 V power supply off or on since pin 5 on U1 is connected
to PE7 on the Rabbit 2000 microprocessor on the backplane. This type of disabling/enabling
allows the analog output channels to float in a high-impedance state.

The voltage regulator on/off is disabled by default when there is a reset or when the D/A
Converter Card is first used. All output channels must be configured to the required volt-
age or current outputs before calling the anaoutEnable function since unconfigured
channels are automatically set to the maximum output.

The -12 V supply is provided only for the SR9410, which provides analog outputs up to +10 V.
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9.5 Software
9.5.1 Sample Programs
e ANAVOUT.Cc—Demonstrates how to set the D/A channel for the desired output.

e sspacil.c—Demonstrates how to recalibrate a D/A converter channel using two known
voltages, and shows how to define the two coefficients, gain and offset, that will be
rewritten into the D/A Converter Card's EEPROM.

e sspac2.c—Demonstrates how to recalibrate a D/A converter channel using an A/D
Converter Card andtwo known voltages. Shows how to define the two coefficients, gain
and offset, that will be rewritten into the D/A Converter Card's EEPROM.

e sspac3.c—Demonstrates how to recalibrate a D/A converter channel using two known
currents, and shows how to define the two coefficients, gain and offset, that will be
rewritten into the D/A Converter Card's EEPROM.

e sspac4.c—Demonstrates how to recalibrate a D/A converter channel using an A/D
Converter Card,two known currents. Shows how to define the two coefficients, gain and
offset, that will be rewritten into the D/A Converter Card's EEPROM.

9.5.1.1 Running Sample Programs

To run a sample program, open it with the File menu (if it is not still open), compile it
using the Compile menu, and then run it by selecting Run in the Run menu. The CPU
Card must be connected to a PC using the programming cable as described in Section 2.3,
“Programming Cable Connections.”

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.

9.5.2 Dynamic C Libraries

The sSMRTSTAR directory contains libraries required to operate the Smart Star control
system.

e SMRTSTAR.LIB—This library supports all the functions needed by the Smart Star sys-
tems including Digital 1/0 Cards, Relay Cards, A/D Converter and D/A Converter
Cards, and serial communication.

Other functions applicable to all devices based on the Rabbit 2000 microprocessor are
described in the Dynamic C Function Reference Manual.
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9.5.3 Smart Star D/A Converter Card Function Calls

void anaOutDisable (void) ;

Turns off (disables) voltage regulator for output-channel op-amps on all D/A Converter Cards, leaving
all output channels in a high-impedance state.

RETURN VALUE
None.

See Also

anaOutEnable, anaOut, anaOutVolts, anaOutmAmps

void anaOutEnable (void) ;

Turns on (enables) voltage regulator for output-channel op-amps on all D/A Converter Cards.

NOTE: The voltage regulator on/off is disabled (off) at power-up or reset. All output
channels must be configured to the required voltage or current outputs before calling
the anaoutEnable function since unconfigured channels will be set automatically to
the maximum output.

RETURN VALUE
None.
SEE ALSO

anaOutDisable, anaOut, anaOutVolts, anaOutmAmps

int anaOutEERd (int channel);

The D/A Converter Card calibration constants, gain, and offset are stored in the factory in the upper half
of the EEPROM on the D/A Converter Card. Use this function to read the D/A Converter Card calibra-
tion constants into the global table daccalib

PARAMETERS
channel is the D/A converter output channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 07
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-7.
RETURN VALUE

0 if successful.
—1—control command unacceptable.
—2—EEPROM address unacceptable.

SEE ALSO

anaOutEEWr
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int anaOutCalib (int channel, int wvaluel,
float voltampl, int value2, float voltamp2);
Calibrates the response of the desired D/A converter channel as a linear function using the two conver-
sion points provided. Gain and offset constants are calculated and placed into global table dacCalib.
PARAMETERS
channel is the D/A converter output channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 07
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-7.

valuel is the first D/A conversion data point. Use a value near 4095 to produce a lower output mea-
surement.

voltampl is the voltage/current measurement corresponding to the first D/A converter value.
Current values entered as milliamps will produce milliamp values, and amp values entered will
produce amp values.

value2 is the second D/A conversion data point. Use a value near 0 to produce a higher output mea-
surement.

voltamp2 is the voltage/current measurement corresponding to the second D/A converter value.
Current values entered as milliamps will produce milliamp values, and amp values entered will produce
amp values.

Approximate Output Equivalent
rawcount
SR9400 SR9410 SR9420
0 (0000H) +10V +10V 20 mA
2047 (OTFFH) +5V ov 12 mA
4095 (OFFFH) oV -10V 4 mA

RETURN VALUE

0 if successful.
-1 if not able to make calibration constants.

SEE ALSO

anaOut, anaOutVolts, anaOutmAmps
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int anaSaveCalib (int boardtype) ;

The calibration constants may also be saved in the flash memory on the Smart Star CPU Card. Doing so
will speed up D/A conversions since a memory access from flash memory will be faster than from
EEPROM. Use anaSaveCalib to save the current set of calibration constants for the analog input or
output channels in the Smart Star flash memory. The calibration constants stored in flash memory can
then be accessed at any time with the anaLoadCalib function.

Calibration constants should first be established using anaoutcCalib or obtained via anaOutEERd.
PARAMETER

boardtype is the type of board, which is 0 for the D/A Converter Card, 1 for the A/D Converter Card.
RETURN VALUE

0 if successful.

—1—attempt to write non-flash area, nothing written.
—2—rootSrce not in root.

—3—timeout while writing flash memory.
—4—attempt to write to 1D block sector(s).

SEE ALSO

analLoadCalib, anaOutCalib

int analLoadCalib (int boardtype) ;

Reads a complete set of calibration constants for the analog output channels from the Smart Star flash
memory on the CPU Card. These should have been loaded to the flash memory with the anaSavecCa-
1ib function.

PARAMETER
boardtype is the type of board, which is 0 for the D/A Converter Card, 1 for the A/D Converter Card.
RETURN VALUE

0 if successful.
—1—attempt to read from non-flash area.
—2—destination not all in root.

SEE ALSO

anaSaveCalib, anaOutCalib
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int anaOut (unsigned int channel,
unsigned int rawcount) ;

Sets the voltage of an analog output channel by serially clocking in 16 bits to a D/A converter using the
following format:

* Program bits (D15...D12)
* New data (D11...D0)

D15 | D14 | D13 | D12 (D11 D10 | D9 | D8 | D7 | D6 | D5 | D4 | D3 | D2 | D1 | DO
R1 | SPD |[PWR| RO | MSB 12 data bits MSB-LSB (0-4095) LSB

SPD—Speed control bit: 1 = fast mode (default), 0 = slow mode
PWR—Power control bit: 1 = power down, 0 = normal operation (default)

The following table lists all the possible combinations of the register-selects bits R1
(Register 1) and RO (Register 0)

R1 RO Register
0 0 Write data to D/A converter channel B
0 1 Write data to buffer
1 0 Write data to D/A converter channel A
1 1 Reserved

PARAMETERS
channel is the D/A converter output channel to write. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 0-7
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-7.

rawcount is a value corresponding to the voltage on the analog output channel (0-4095). The follow-
ing rawcount data correspond to the analog outputs indicated.

Approximate Output Equivalent
rawcount
SR9400 SR9410 SR9420
0 (0000H) +10V +10V 20 mA
2047 (OTFFH) +5V ov 12 mA
4095 (OFFFH) ov -10V 4 mA

RETURN VALUE

0 if successful.
-1 if rawcount is greater than 4095.

SEE ALSO

anaOutVolts, anaOutCalib
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void anaOutVolts (unsigned int channel,
float voltage) ;
Sets the voltage of an analog output channel by using the previously set calibration constants to calculate
correct data values.
PARAMETERS
channel is the D/A converter output channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 0-7
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-7.
voltage is the voltage desired on the output channel.
RETURN VALUE
None.
SEE ALSO

anaOut, anaOutCalib, anaOutmAmps

void anaOutmAmps (unsigned int channel,
float current) ;

Sets the current of an analog output channel by using the previously set calibration constants to calculate
correct data values.
NOTE: The factory-set calibration constants are for current measurements in amperes.
PARAMETERS
channel is the D/A converter output channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)
where slotnumber is 0-6, and channelnumber is 0—7
or
channel = ChanAddr (slotnumber, channelnumber)
where slotnumber is 0-6, and channelnumber is 0-7.
current is the current range (4—20 mA or 0.004-0.020 A) desired on the output channel.
RETURN VALUE
0 if successful.
-1 if not able to make calibration constants.
SEE ALSO

anaOut, anaOutVolts, anaOutCalib
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int anaOutEEWr (int channel) ;
Writes the calibration constants, gain, and offset to the upper half of the EEPROM on the D/A Converter
Card.

PARAMETERS

channel is the D/A converter output channel. channel should be passed as
channel = (slotnumber * 128) + (channelnumber)

where slotnumber is 0-6, and channelnumber is 0—7

or
channel = ChanAddr (slotnumber, channelnumber)

where slotnumber is 0-6, and channelnumber is 0-7.

voltage is the voltage desired on the output channel.

RETURN VALUE

0 if successful.

-1—control command unacceptable.
-2—EEPROM address unacceptable.
-3—data value unacceptable.

SEE ALSO

anaOutEERd
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9.6 Electrical and Mechanical Specifications
Figure 44 shows the mechanical dimensions for the D/A Converter Card.
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<3 0~
N~ ~Q

Nv

Figure 44. D/A Converter Card Dimensions

NOTE: All diagram and graphic measurements are in inches followed by millimeters
enclosed in parentheses.
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Table 19 lists the electrical, mechanical, and environmental specifications for the D/A
Converter Card.

Table 19. D/A Converter Card Specifications

Parameter Specification
. 2.73" x 3.00" x 0.44"
Board Size (70 mm x 76 mm x 11 mm)
Connectors one 2 x 10 latch/eject ribbon connector, 0.1 inch pitch

Operating Temperature

—40°C to +70°C

Humidity

5% to 95%, noncondensing

Power Requirements

5V DC at 50 mA typical from backplane (+5 V supply)

15V 1030V DC, 30 mA at 24 VV DC, +RAW/+V_USER from
backplane

Number of Outputs 8 channels
SR9400: 0 V to +10 V, 20 mA/channel (maximum)
Analog Output Ranges SR9410: -10 V to +10 V, 20 mA/channel (maximum)
SR9420: 4 mA to 20 mA, 10 V (maximum)
Resolution 12 bits (0-4095)

Conversion Time
(including Dynamic C)

0.2 ms/channel

Output Stability % count
SR9400: <1 Q,
Output Impedance SR9410: <1 Q,

SR9420: > 100 kQ
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PART V. RELAY CARDS
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10. RELAY CARDS

Chapter 10 describes the features of the Relay Card, one of the
I/0O cards designed for the Smart Star embedded control system.

The Smart Star is a modular and expandable embedded control system whose configura-
tion of 1/0, A/D Converter, D/A Converter, and Relay Cards can be tailored to a large
variety of demanding real-time control and data acquisition applications.

The typical Smart Star system consists of a rugged backplane with a power supply, a CPU
card, and one or more 1/O cards. The CPU card plugs into a designated slot on the back-
plane chassis, which has seven additional slots available for I/O cards to be used in any
combination. A high-performance Rabbit 2000 microprocessor on the CPU card provides
fast data processing.

10.1 Relay Card Features

Two models of Relay Cards are available, as shown in Table 20.

Table 20. Smart Star Relay Cards

I/0O Card Model Features

5 SPST relays and 1 SPDT relay, each protected

SR9500 with onboard snubbers

Relay

SR9510 8 SPDT relays (no snubbers)

The SR9500 Relay Cards are suitable for switching all kinds of loads upto 30 V DCat 1 A
or 48V AC at 0.5 A. The SR9510 handles similar loads, but is restricted to noninductive
loads unless you add snubbers to the system that is interfacing with the Smart Star.
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10.2 User Interface

Depending on the model of Relay Card (see Table 20), the relays on the Relay Card will be
configured as SPDT or SPST with or without snubbers. Figure 45 shows these relay configura-
tions.

+V
COM 8 ;4
e H-o il SPDT
A (no snubbers)
NC 9 10 | RELDRV
+V
coM 8 . 4
100nF 470 7
NO B _SPDT
1000F 470 . " RELDRY (with snubbers)
NC
+V
COoM 8 P
10|0 nF 470 7
o W 1 . % SPST
-2 (with snubbers)
10 | RELDRV

Figure 45. Relay Configurations

The diode protects the coil power supply (and the Smart Star backplane) from inductive
spikes caused by energizing/de-energizing the coil, and the resistor-capacitor snubbers
protect the relay contacts against voltage spikes induced by inductive loads.

Figure 46 shows the complete pinout for the user interface on header J1. Note that pin 1 is
indicated by a small arrow on the ribbon cable connector.

SR9500 SR9510
1 1
GND |®m o | RELONO GND |m o | RELONO
RELONO | o o| RELOCOM RELOCOM | o o | RELONC
RELOCOM | o o| GND RELINO |o o | GND
RELINO | & ©| REL1NO REL1COM | o o | RELINC
REL1COM | o o | REL1COM /OO, Ioooooooooo ooooooooooooz (=) REL2NO |5 ©| REL2COM
REL2NO | o o| GND 0000000000 0000000000 REL2NC [o o | GND
REL2COM | o o | REL2NO v REL3NO (5 ©| REL3COM
REL3NO | o ©o| REL2COM REL3NC |2 5| REL4ANO
GND | o o | REL3NO GND | o o | REL4COM
REL3COM | o © | REL3COM REL4NC |2 5| REL5NO
REL4NO | o o| REL4NO REL5COM | @ o | RELSNC
REL4COM | o = | REL4ACOM RELBNO | o = | REL6COM
GND | o 0| REL5NO GND | o 0| REL6NC
REL5NO | o ©| REL5COM REL7NO | o & | REL7COM
REL5COM | & © | RELSNC REL7NC o ©
GND | o o | REL5SNC GND |o &
GND o o o o

Figure 46. Relay Card User Interface Pinout
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10.3 User FWT Connections

Connections to the Relay Cards are made via a ribbon cable connector or optional field
wiring terminals that are either pluggable or have screw terminals. Table 21 lists the

Rabbit part numbers for the FWTs.

Table 21. Guide to FWT Selection

Rabbit Part Number

Pluggable Terminals

Screw Terminals

FWT Description I/O Cards
FWT18R Relay (SR9500) 101-0422 101-0516
FWT27 Relay (SR9510) 101-0420 101-0514
10.3.1 Pinouts
Figure 47 shows the pinout for the FWT18R FWT27
FWTs used on the Relay Cards. SR9500 — 6-relay card | SR9510 — 8-relay card
1Tolleno
2|| | ReLono
3|| || RELocOM
4||o|[ReLone
— s||@|freLino
1{{@|fRELONO 6/|o||rREL1COM
2||o||RELOCOM N ollrecine
3||O|fcND 8l|o|[[REL2NO
4{[@[fRELINO 9||@||REL2cOM
ue 2| Q[|RELICOM = o10||@|[REL2NC
28 6||@||cND e211||o|[REL3NO
o2 /|[DffRE-2NO 8212 |[REL3COM
:: 8||@|||REL2COM ::13 o|lRreLanc
22 9[|QffeNo o814/ |[REL4NO
82 10||Q[|REL3NO e s15||0||REL4COM
5511 o|IreL3COM 5516 ollreLanc
0 o 4
4 e 18| ||RELsCOM
14|@||ReL4cOM 1ollollRecanc
15([@]|GND 20| @ |[ReL6NO
16/ [|RELSNO 21|[@|[reLecom
17||@||ReLscom ool llReLenc
18.9. RELSNC 23(|@||REL7NO
24(|D||REL7COM
25([@||[ReL7NC
2|l@
27| o || snD

Figure 47. FWT Pinouts for Relay Cards
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10.4 Power Distribution

Figure 48 shows the power distribution on the Relay Card.

BACKPLANE
SLOT 0-6

20 +5V Multiplexer/
Latch

+12 V linear

|_ regulator
22 +V-USER +12 V coil actuation
voltage
Comparator

Figure 48. Relay Card Power Distribution

—

The relay coil actuation voltage is 12 V, and so +V_USER should be 12 VV to 30 V DC. The
+V_USER supply passes through a linear regulator and comparator, which are in parallel.
The comparator is set for approximately +13.9 V, and as long as +V_USER is more than
+13.9V, the +12 V from the linear regulator will provide the coil actuation voltage.
Should +V_USER be less than +13.9 V, the comparator will supply +V_USER directly to
provide the coil actuation voltage.
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10.5 Relay Cards Software

10.5.1 Sample Programs

e SSTARRLY.C—Demonstrates turning a relay on the Relay Card on and off.
10.5.2 Running Sample Programs

To run a sample program, open it with the File menu (if it is not still open), compile it
using the Compile menu, and then run it by selecting Run in the Run menu. The CPU
Card must be connected to a PC using the programming cable as described in Section 2.3,
“Programming Cable Connections.”

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.

10.5.3 Dynamic C Libraries

The sSMRTSTAR directory contains libraries required to operate the Smart Star control
system.

e SMRTSTAR.LIB—TNhIs library supports all the functions needed by the Smart Star sys-
tems including Digital 1/0 Cards, Relay Cards, D/A Converter and A/D Converter
Cards, and serial communication.
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10.5.4 Smart Star Relay Card Function Calls

void relayOut (int relay, int wvalue);

Sets the state of a relay.
PARAMETER
relay is the relay to set. relay should be passed as
relay = (slotnumber * 128) + (relaynumber)
or
relay = ChanAddr (slotnumber, relaynumber)

where slotnumber is 0-6, and relaynumber is 0-5 (SR9500) or 0-7 (SR9510), depending on the
model of Relay Card.

value is the value to set the relay to, 0 or 1 (off or on).
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10.6 Electrical and Mechanical Specifications

Figure 49 shows the mechanical dimensions for the Relay Card.
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Figure 49. Relay Card Dimensions

NOTE: All diagram and graphic measurements are in inches followed by millimeters
enclosed in parentheses.
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Table 22 lists the electrical, mechanical, and environmental specifications for the Relay
Card.

Table 22. Relay Card Specifications

Parameter Specification
Board Size (70 mm 76 mm ¢ 11 mi)
Connectors one 2 x 17 latch/eject ribbon connector, 0.1 inch pitch
Operating Temperature -40°C to +70°C
Humidity 5% to 95%, noncondensing
5V DC at 10 mA from backplane (+5 V supply)
Power Requirements 12V 1030V DC, 10 mA at 24 V DC, +RAW/+V_USER from

backplane

Relay Switching Contacts 30vVDCatlAor48V ACat05A

SR9500: 1 SPDT, 5 SPST (N.O., COM) with snubbers

Rel
elays SR9510: 8 SPDT (N.O., N.C., COM), no snubbers

124 Smart Star Relay Cards (SR9500)



PART VI. APPENDICES
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APPENDIX A.
FIELD WIRING TERMINALS

Appendix A explains how to prepare the connector on an 1/0
card to accept a field wiring terminal, and how to secure the
field wiring terminal to the 1/O card. The dimensions for the
field wiring terminals are included.
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A.1 Selecting and Installing a Field Wiring Terminal

Connections to the 1/O cards are made via a ribbon cable connector or optional field wiring
terminals that are either pluggable or have screw terminals. Three different Field Wiring
Terminals (FWTSs) are available. Table A-1 lists the /O cards and the Rabbit part numbers
for the corresponding FWTs.

Table A-1. Guide to FWT Selection

Rabbit Part Number
Pluggable Terminals Screw Terminals
. o
FWT Description I/O Cards TS
Digital 1/0 (SR9200 series) i )
FWT27 Relay (SR9510) 101-0420 101-0514
AJD Converter (SR9300 series)
FWT18 D/A Converter (SR9400 series) 101-0421 101-0515
FWT18R Relay (SR9500) 101-0422 101-0516

Before you can install the FWT you selected
for your 1/O card, you must remove the tabs m @ m
from the connector on the 1/0 card. To do so,

move the tab inwards as far as possible, as f@
shown in Figure A-1. Then insert a screw-

driver into the space below the tab on the
side of the connector and gently nudge the

tab up and out. If you are careful, the tab will
remain intact to be saved and snapped back

oooooooooooooooooooooooo

Figure A-1. Remove Tabs from Connector

. - on /O Card

in place should you need to use a ribbon

cable connector in the future.

Plug the FWT connector into the connector = 7
on the 1/O card. Be sure to position the plug- g

ggble or screvy conngctors so that the header Pin 1 Mylar msu/a tor ‘
pins on the printed circuit board are towards ) |
you, as shown in Figure A-2. Position the ——— ‘Ei”””

& OO0 0000000000000

mylar insulator above the FWT as shown in
Figure A-2 to protect the header pins on the
printed circuit board, and secure the FWT
using the two 4-40 x ¥4 screws supplied.
them. Note that the mylar insulator will be
bowed slightly once the screws are in place.

Figure A-2. Secure FWT to I/O Card
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A.2 Dimensions
Figure A-3 shows the overall FWT dimensions.
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Figure A-3. FWT Dimensions

NOTE: All diagram and graphic measurements are in inches followed by millimeters
enclosed in parentheses.

The actual appearance of the terminals may vary, depending on the number and type of
terminals. The pinouts for the FWTs applicable to a particular 1/O card are shown with the

pinouts for the connectors on the individual 1/0 cards.
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APPENDIX B. LCD/KEYPAD MODULE

An optional LCD/keypad module with a NEMA 4 water-resis-
tant bezel is available for the Smart Star. Appendix B describes
the LCD/keypad module and provides the software function
calls to make full use of the LCD/keypad module.

B.1 Specifications

The LCD/keypad module comes with or without a panel-mounted NEMA 4 water-resistant
bezel as shown in Figure B-1.

LCD/Keypad Modules

0O @00@0@0@00 eo0ococoo0

2808

B 0a

Figure B-1. LCD/Keypad Module Versions

Either version can be connected to the Smart Star backplane, and can be installed at a remote
location up to 60 cm (24") away. Contact your Rabbit sales representative or your autho-
rized distributor for further assistance in purchasing an LCD/keypad module.

Mounting hardware and a 60 cm (24") extension cable are also available for the LCD/key-
pad module through your sales representative or authorized distributor.
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Table B-1 lists the electrical, mechanical, and environmental specifications for the LCD/

keypad module.

Table B-1. LCD/Keypad Specifications

Parameter Specification
. 2.60" x 3.00" x 0.75"
Board Size (66 mm x 76 mm x 19 mm)
Bezel Size 4.50" x 3.60" x 0.30"
(124 mm x 91 mm x 7.6 mm)
Operating Rang